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• The Norton Disk Doctor can diagnose and repair 
your disk problems automatically. 
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Other titles include Up & Running with: 
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• DOS 3.3 

• Flight Simulator 

• Harvard Graphics 

• Lotus 1-2-3 Release 2.2 

• Lotus 1-2-3 Release 3.1 

• Norton Utilities 

• PageMaker 4 on the PC 

• PageMaker on the Macintosh 

• PC Tools Deluxe 6 

• PC-Write 

• PROCOMM PLUS 

• Q&A 

• Quattro Pro 3 

• Quicken 4 

• ToolBook for Windows 

• Thrbo Pascal 5.5 

• Windows 3.0 
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• • • • • • 
Computer users are not all alike. 
Neither are SYBEX books. 

We know our customers have a variety of needs. They' ve told us 
so. And because we've listened, we've developed several distinct 
types of books to meet the needs of each of our customers. What 
are you looking for in computer help? 

If you're looking for the basics, try the ABC's series, or for a more 
visual approach, select Teach Yourself. 

Mastering and Understanding titles offer you a step-by-step 
introduction, plus an in-depth examination of intermediate-level 
features, to use as you progress. 

Our Up & Running series is designed for computer-literate 
consumers who want a no-nonsense overview of new programs. 
Just 20 basic lessons, and you're on your way. 

SYBEX Encyclopedias provide a comprehensive reference and 
explanation of all of the commands, features and functions of the 
subject software. 

Sometimes a subject requires a special treatment that our 
standard series doesn't provide. So you' ll find we have titles like 
Advanced Techniques, Handbooks, Tips & Tricks, and others 
that are specifically tailored to satisfy a unique need. 

You'll find SYBEX publishes a variety of books on every 
popular software package. Looking for computer help? 
Help Yourself to SYBEX. 

For a complete catalog of our publications: 

• • • • • • • • • • • 
SYBEXInc. 
2021 Challenger Drive, Alameda, CA 94501 
Tel: (415) 523-8233/(800) 227-2346 Telex: 336311 
Fax: (415) 523-2373 
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The Up & Running series of books from SYBEX has been devel
oped for committed, eager PC users who would like to become 
familiar with a wide variety of programs and operations as quickly 
as possible. We assume that you are comfortable with your PC and 
that you know the basic functions of word processing, spread
sheets, and database management. With this background, Up & 
Running books will show you in 20 steps what particular products 
can do and how to use them. 

Up & Running books are designed to save you time and money. 
First, you can avoid purchase mistakes by previewing products 
before you buy the~xploring their features, strengths, and 
limitations. Second, once you decide to purchase a product, you 
can learn its basics quickly by following the 20 steps-even if 
you are a beginner. 

The first step usually covers software installation in relation to 
hardware requi rements. You'll learn whether the program can op
erate with your available hardware as well as various methods for 
starting the program. The second step often introduces the pro
gram's user interface. The remaining 18 steps demonstrate the 
program's basic functions, using examples and short descriptions. 

A clock shows the amount of time you can expect to spend at your 
computer for each step. Naturally, you' ll need much Jess time if 
you only read through the step rather than complete it at your 
computer. 

• 

• 

You can also focus on particular points by scanning the short notes 
in the margins and locating the sections you are most interested in. 



In addition, three symbols highlight particular sections of text: 

The Action symbol highlights important steps that you will 
carry out. 

The Tip symbol indicates a practical hint or special technique. 

Iiiii 
The Warning symbol alerts you to a potential problem and sug
gestions for avoiding it. 

We have structured the Up & Running books so that the busy user 
spends little time studying documentation and is not burdened 
with unnecessary text. An Up & Running book cannot, of course, 
replace a lengthier book that contains advanced applications. 
However, you will get the information you need to put the pro
gram to practical use and to learn its basic functions in the shortest 
possible time. 

SYBEX is very interested in your reactions to the Up & Running 
series. Your opinions and suggestions will help all of our readers, 
including yourself. Please send your comments to: SYBEX Edito
rial Department, 2021 Challenger Drive, Alameda, CA 94501. 



Preface 
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The Norton Utilities for the Macintosh occupy a unique position 
in the Macintosh world. They add to the Macintosh operating sys
tem in several important ways: they provide the tools for diagnos
ing and repairing disks and restoring erased files, they provide 
programs that let you optimize your Macintosh's resources effi
ciently, and they extend the capabilities of the desktop with desk 
accessories and control panel devices that speed up and simplify 
your normal operations. 

This book describes the Norton Utilities version 1.0 for the 
Macintosh and is organized into 20 Steps. Each Step describes a 
specific utility, but you don' t have to read the Steps in sequence. 
Because each of the Steps is self-contained, you can just read 
about the utilities you are most interested in. 

REQUIREMENTS FOR 
RUNNING THE UTILITIES 
The Norton Utilities will run on several versions of the Macintosh 
operating system. You must have System 4.2, 6.0.2, 6.0.3, 6.0.4, 
or 6.0.7 in order to use the utilities. 

As for hardware, the Norton Uti lities will run on the Mac Plus; the 
Macintosh Portable; the SE and SE 30; and the Macintosh II, IIx, 
Ilcx, and Ilci. They also run on the new Macs: the Classic, LC, and 
Ilsi. A hard disk is recommended, although not required, and you 
must have at least one megabyte of memory. 
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• Installation 
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This first Step introduces the Norton Utilities, explains how to 
make copies of the original distribution disks, and describes how 
to install the Norton Utilities onto your hard disk. 

A BRIEF INTRODUCTION 
TO THE NORTON UTILITIES 
The Norton Utilities for the Macintosh consist of three applica
tions, two desktop accessories, three startup documents, and a 
help file. This section gives a short description of each of the Nor
ton Utilities. 

The Norton Utilities program is the heart of the package, and it 
contains the Norton Disk Doctor for diagnosing and repairing disk 
problems, UnErase for recovering accidentally deleted ftles, For
mat Recover for restoring data to an accidentally formatted hard 
disk, and the Norton Disk Editor for looking at and changing disk 
information. 



SpeedDisk is a disk optimizer you can use to increase your disk 
performance. 

Layout Plus lets you customize the Finder and change the appear
ance of your desktop. 

Fast Find is a desk accessory that replaces Find File. 

KeyFinder is a desk accessory that adds to the capability pro
vided by Key Caps. 

FileSaver is a startup document and control panel that provides 
protection for hard disks. Both Format Recover and UnErase can 
use information saved by FileSaver when they recover lost data. 

Directory Assistance is a startup document that gives greater ca
pability to the standard Open, Save, and Save As dialog boxes 
used by almost all your application programs. 

DiskLight is a startup document and control panel that tells you 
when a disk is being read or written to. 

MAKING BACKUP 
COPIES OF THE ORIGINAL DISKS 
As with any software you buy, the first thing you should do after 
taking it out of the box is back it up. Do this even if you plan to 
install the software on your hard disk. In the event that the origi
nal disks are damaged in an accident, these backup copies ensure 
that the software is still available. 

Making Backups Using Floppy Disks 
You can copy the contents of one floppy disk to another using a 

& Running with Norton Utilities on the Macintosh 



single drive; however, you will have to change disks several 
times. 

1. Eject any floppy disk currently in the drive and insert a for
matted blank disk. 

2. Select the disk's icon and choose Eject from the File menu. 
This ejects the disk but leaves its dimmed icon on the 
desktop. You need this dimmed icon on the desktop before 
you can start the copy. 

3. Insert one of the original Norton Utilities distribution disks 
and drag its icon across to the destination disk's dimmed 
icon. The Macintosh confirms that you want to replace the 
original contents of the destination disk, and then starts 
the copy process. You are prompted to swap the disks over 
until the copy is complete. 

4. When you have finished copying, rename the destination 
disk to reflect its new contents, put a label on the disk, and 
store it in a safe place. Don't forget to write-protect the 
disk by sliding back the write-protect tab in the upper right 
comer of the disk. 

Repeat this process for each of the disks in the Norton Utilities 
package. 

Making Floppy 
Backups Using Your Hard Disk 
If you bought the Norton Utilities because you currently need to 
perform a recovery operation such as unerasing a file, do not in
stall the programs onto your hard disk yet. Instead, use the Norton 
Utilities from the red Emergency disk to recover the file. When 
the recovery is complete, you can continue with the installation 
procedure. If you install the Norton Utilities without first recover
ing the file, you might accidentally overwrite the area of the 



disk occupied by the erased file, making its recovery impossible. 
For more details, see the Steps describing disk repair and me 
recovery. 

If you have one floppy disk drive and one hard disk, you can use 
the hard disk as an interme<tiate step to avoid disk swapping when 
duplicating a floppy. Here's how to do it: 

1. Insert the original distribution disk into the floppy disk 
drive. 

2. Select the hard disk icon and choose Open from the File 
menu, or double-click on the hard disk icon to open it. 

3. Drag the source disk icon to the directory window of your 
hard disk. A window opens to remind you that the two 
disks are of different types and that the contents of the 
source disk will be placed in a folder on the hard disk. 
Click on OK to start the copy. When the copy is complete, 
you will see a new folder on your hard disk with the same 
name as the source disk. 

4. Eject the source disk by dragging its icon to the Trash. 

5. Insert the destination disk, click on the new folder to high
light it, and then choose Open from the File menu. 

6. Select all the icons inside the folder by using Select All 
from the Edit menu. All the icons in the window will be 
highlighted. 

7. Drag the highlighted icons on to the icon for the destination 
disk, and all the selected files and folders will be copied 
across. 

8. When the copy is complete, rename the destination disk to 
reflect its new contents, put a label on the disk, and store it 
in a safe place. 

& Running with Norton Utilities on the Macintosh 



When you have copied the Norton Utilities disks, slide back the 
write-protect tab in the upper right comer of each disk using a 
pencil or a paper clip so that you can see through the hole. This 
makes the disks read-only disks-a useful protection against acci
dental erasure. 

USING THE NORTON 
UTILITIES FROM A FLOPPY DISK 
If you do not have a hard disk, you can launch the Utilities from 
your backup copy of the Applications or the Emergency disk. 

The Norton Utilities, comprising the Norton Disk Doctor, Un
Erase, Format Recover, and the Norton Disk Editor are on the 
Emergency disk. SpeedDisk, Directory Assistance, DiskLight, 
Fast Find, FileSaver, KeyFinder, and Layout Plus are on the Ap
plications disk. The Installation disk contains the Installer, the 
Help file, and several important Read Me files. 

INSTALLING THE NORTON 
UTILITIES ONTO YOUR HARD DISK 
If you bought the Norton Utilities because you currently need to 
perform a recovery operation such as unerasing a file, do not in
stall the programs onto your hard disk yet. Instead, use the Norton 
Utilities from the Emergency disk to recover the file. When the 
recovery is complete, you can continue with the installation pro
cess. If you install the Norton Utilities without first recovering the 
file, the installation process might overwrite the area of the disk 
occupied by the erased file, making recovery impossible. 

The Norton Utilities Installer will install all the Norton Utilities, 
the online help, and the color icons. The Installer guides you 



through this installation procedure step by step, explaining the 
choices available at every stage. You will need over a megabyte 
(MB) of free space on your hard disk to do a complete installation 
of all the utilities. 

The default settings are as follows: install all the utilities, the on
line help system, and color if the Mac has color capability; install 
the Desk Accessories in a system file unless you use a resource 
optimizer like Suitcase IT; and install the startup documents into 
the system folder. 

Insert the Installation disk into your disk drive, and when the disk 
icon appears, double-click to open it. Then double-click on the In
staller to launch the installation program. 

The first Installer window contains a dialog box reminding you 
not to install the utilities if your hard disk currently contains files 
you want to recover. You should use the red Emergency disk to 
recover the file or files, and then continue with the installation af
ter the files have been recovered. If you are ready to continue with 
the installation now, notice that this dialog box has the following 
buttons: 

• Drive toggles through the list of mounted disk drives until 
the name of the disk that you want to install the utilities on 
is shown above the button. 

• Customize allows you to choose between several options, 
including which of the utilities to instaJI, whether the 
Desk Accessories are installed in the system file or in a 
separate folder, whether Help is installed, and whether 
color resources are installed. Choose color only if you 
have a Mac with a color or gray-scale monitor; installing 
color adds approximately 150K to the size of the Norton 
Utilities. 

& Running with Norton Utilities on the Macintosh 



• Help provides information to guide you through the choices. 

• Quit exits the Installer and returns you to the Finder. 

• Install starts the installation process. 

Use Customize if you don't want to install all the utilities or if you 
want to alter the default settings. Click on the appropriate utility 
icon to toggle the highlighting off and on. If highlighting is off, 
the utility will not be installed. Click on the radio buttons to deter
mine where to install the desk accessories-put them in the sys
tem or in a separate folder. Click on the two checkboxes to install 
the online help system and the color resources. When you have 
made aJl . your choices, click on OK to return to the previous In
staller window. Now click on Install and follow the screen 
prompts, changing disks as requested. When the installation is 
complete, you will see a report on the screen detailing what was 
installed where on your disk. 

Because the Installer copies system resources, you may well see 
messages from a virus detector if you use one. Either tum off the 
detector while you install the Norton Utilities or click on the box 
that allows the process to continue. If you turn off your virus 
detector, don't forget to tum it back on again when the Installer 
is done. 

You must restart your Macintosh to activate the startup documents 
you installed. Click on Restart when you are ready; otherwise, 
click on Quit to return to the Finder. 

LOOKING AT THE 
READ ME FILES USING TEACHTEXT 
Several Read Me documents are included with the Norton Utili
ties, and you should check these files for the latest information 



that may not have made it into the manual. The fastest way to look 
at one of these files from the Finder is to double-click on the Read 
Me document icon. TeachText starts automatically and displays 
the contents of the Read Me file you selected. You can also use 
Teach Text to print the contents of the Read Me document. 

& Running with Norton Utilities on the Macintosh 
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·~· The User Interface • 

• • • • • • • • • • • 

This Step describes the Norton Utilities user interface, or more 
correctly, it describes how the Norton Utilities use the standard 
Macintosh user interface. If you have used other programs on the 
Mac, you will have no difficulty using the Norton Utilities. 

USING THE MOUSE 
In the Norton Utilities, the mouse works just as you would expect 
it to; the on-screen cursor follows the movements you make with 
the mouse. Use the mouse to point to an icon on the screen or to 
pull down a menu to work with. Click on your choice by moving 
the on-screen cursor to the selection you want, and then pressing 
and releasing the mouse button. 

Double-clicking requires that you press and release the mouse but
ton twice in quick succession. Double-clicking on an icon is often 
used to select a document and launch the application program that 
created that document at the same time. 



SCROLLABLE LISTS 
If a list is sorted into alphabetical order, you can just type the ini
tial letter of the item to select it. If the list is not sorted alphabeti
cally, then you must use an exact-match search instead. 

If you can choose an item from the list, you can use the following 
keys to help you make your selection: 

• i : Moves the highlighted bar up one row. Pressing the i 
key can also scroiJ the display up one row if you are at the 
top of a window. 

• J.: Moves the highlighted bar down one row. Pressing the J. 
key can also scroll the display down one row if you are at 
the bottom of a window. 

• Home (Command-i): Moves to the top of the list and 
selects the first item in the list. 

• End (Command-J. ): Moves to the bottom of the list and 
selects the last item in the list. 

• PgUp (Command-Option-i): Moves up the list one screen 
and selects the last item displayed. 

• PgDn (Command-Option-J. ): Moves down the list one 
screen and selects the flrst item displayed. 

SHORTCUT KEYSTROKES 
In addition to the Mac user interface you are familiar with, the 
Norton Utilities provide some additional capabilities, including 
shortcut or hotkey sequences. You can use these command key 
shortcuts when selecting buttons in a dialog box. For example, if a 
button is labeled Drive, you can use Command-O instead of click
ing on the Drive button. The Enter key always selects the default 

·& Running with Norton Utilities on the Macintosh 



button; Escape, Command-., Command-C, and Clear all select the 
Cancel button. 

If a dialog box has only one option, for example, an OK button, 
and it does not contain scrollable lists or text fields, you don't 
have to use Command-O to select the OK button; you can just 
press 0 by itself. 

When you use a shortcut, the chosen button always flashes so that 
you can be sure that the button has been accepted. 

WORKING WITH DISK DRIVES 
When you are working with disk drives, clicking on the drive icon 
has the same result as clicking on the Drive button: you select the 
next drive on your Mac in sequence. If you hold down the Option 
key and click on the drive icon, you move backwards through 
your list of drives. This is the same as holding down the Option 
key and clicking on the Drive button. The Tab key also performs 
the same function as the Drive button in dialog boxes, selecting 
each drive in sequence, and Option-Tab cycles backwards through 
the list of available drives. 

USING RADIO BUTTONS 
If a dialog box has a set of radio buttons and does not contain 
scrollable lists or text fields, you can double-click on the radio 
button to select the radio button and choose the OK button simul
taneously. It is as though you had clicked the radio button and the 
OK button as two separate actions but is much faster. 

The User 
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- -~· Using Help • 

• • • • • • • • • • • 

The Norton Utilities have an extensive help system avai lable to 
guide you through the application programs. This help system is 
based on the Norton Guide hypertext display database and 
is available online anytime you are using the Norton Utilities. The 
Norton Guide hypertext display database allows text entries to be 
linked together in a complex set of relationships. To access this 
help, press Command-H or click on Help in the Apple menu, and 
you will see the Norton Uti lities Help window as shown in Fig
ure 3.1. 

The Help window has five main icons across the top of the screen, 
and they are used as follows: 

• Topics: Choose Topics to see a list of all the Norton Utili
ties arranged in the sequence: Utilities, Desk Accessories, 
Startup Documents, and How to Use This Online Help. 

• Glossary: Select Glossary to see a list of approximately 50 
technical terms related to the Mac. 
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• Figure 3.1: The Norton Utilities Help Window 

• Go Back: Click on the Go Back icon (a curved arrow) or 
press Escape after displaying a help entry to return to the 
previous topic in the help system. The Norton Utilities can 
keep track of the last 15 topics you looked at, and you can 
move backwards through this list one step at a time, each 
time you click on Go Back. 

• BookMarks: Choose BookMarks to tag or mark an entry in 
the help system so that you can access the entry very 
quickly. You can use up to ten different bookmarks at a 
time. 

• See Also: Click on See Also to display a menu of the other 
help options available. If you choose Topics, the See Also 
menu contains the Glossary; if you choose the Glossary, 
the menu contains Topics and the Norton Utilities; if you 
choose the Norton Utilities, the menu contains Topics and 
the Glossary. 

p & Running with Norton Utilities on the Macintosh 
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LOOKING AT TOPICS 
To select a Topic, move the mouse to one of the underlined entries 
in the list. When the cursor changes to a magnifying glass, click 
on the Topic to see the related help window. For even faster ac
cess, just type the first letter of a Topic, and the highlight moves to 
that Topic. Press Return to see the help window. You can use 
Command-A with < or > to find other matching Topics, and you 
can use the i and J. keys, as well as Home, End, PgUp, and 
PgDn, to scroll through the list. 

If you are looking at a Help screen and you see that a section of 
the Help text is underlined, you can click on this item to see addi
tional help on that topic, too. 

All of the information in the Norton Utilities Help database is ar
ranged so that related subtopics follow each of the main topics. To 
look at these subtopics, use Command+- and Command-~ as 
Previous and Next buttons. You can also click on the two arrow 
icons at the top of the Norton Utilities Help window to perform 
the same functions. For example, if you ask for help on the first 
Topic in the list, Norton Utilities (Main Menu), you will see the 
Help window shown in Figure 3 .2. 

In this screen, the text Norton Disk Doctor is underlined; this 
means that you can ask for help on this subject. If you do, you 
will see another window of help on the Norton Disk Doctor. In 
this screen the text Sad Mac is underlined, indicating that more 
help is available on this subject too. Click on the Go Back button 
to return to your original place in the help system. 

USING THE GLOSSARY 
Once you can use Topics, you will find the Glossary very easy to 
use. Click on the Glossary icon, or select Glossary from the See 
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• Figure 3.2: The first Help window tor the Norton Utilities 

Also menu. The Glossary contains nearly 50 different entries in 
alphabetical order on technical subjects related to the Mac. Just as 
with Topics, you select an underlined Glossary entry by using the 
mouse, and you scroll the topics with the arrow keys. Once the in
formation is shown in the Help window, you can use the same 
keys to move through the Help text that you used with Topics, and 
you can also use the two arrow icons at the top of the window as 
Previous or Next buttons. 

SETTING AND CLEARING BOOKMARKS 
You can mark your place in the Help system and go to it very 
quickly if you use one of the ten BookMarks. Use the following 
steps to mark an entry with a BookMark: 

1. Find the starting Topic or Glossary entry that you want to 
mark with a BookMark. 
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2. Scroll through the Help text until you find the place where 
you want to place the BookMark. 

3. Click on the BookMarks menu, select Set BookMark, and 
then choose the number of the BookMark you want to use 
from BookMark 0 to BookMark 9. 

The BookMark is now set; to access the marked Help text from 
anywhere within the Help system, press Command -n, where n is 
the number of the BookMark. For BookMark 0, press Command
O; for BookMark 1, press Command- I; and so on. 

A faster way of doing the same thing but without using the Book
Marks menu, is to move to the place in the Help window that you 
want to mark, and press Command-Option-n or Command
Control-n, where n represents a number between 0 and 9. This sets 
BookMark n to the current place in the Help window. You access 
the BookMark with the same Command-n key sequence as before. 

BookMarks are saved from one Help session to another so you do 
not have to reset them each time you use Help. 

To clear a BookMark, click on the BookMarks menu, but this time 
choose Clear BookMark, and then select the number of the Book
Mark you want to clear. 

SEARCHING WITH THE GLOBAL FIND 
If you remember that there is information on a certain topic in the 
Help system but you cannot remember how to access it, you can 
use the Global Find to track it down. Press Command-F to bring 
up the Search dialog box, and enter the text you want to search 
for. The search is not case sensitive, so window matches with Win
dow and WINDOW Next click on one of the radio buttons to se
lect the search mode. Page Search looks at the contents of the 
current window for the search text; Global Search looks through 



the whole Help system for the search text and may take a little 
longer. You can use Comrnand-P to select Page Search or Com
mand-O to select Global Search. Click on Find to start the search. 
When a match is found, the line containing the match is shown on 
the screen with a highlight. Press Command-A to continue the 
search for another occurrence of the search string. When there are 
no more matches remaining, you will hear the Macintosh Alert 
sound to tell you that the search is complete. 

Remember, this search is for any text anywhere in the Help sys
tem, not just the underlined entries in Topics or in the Glossary. 

To exit Help and return to the Norton Utilities, click on the active 
Norton Utilities window. To return to the Help system again, click 
on the active Help window. To leave Help and close its window, 
click on the close box in the upper left corner of the Help window. 
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FileSaver is an important part of the Norton Utilities. By using it, 
you can save yourself a great deal of time and !rouble if you ever 
have an accident involving your hard disk. It is an insurance pol
icy, and it is a good example of the prevention being better than 
the cure. FileSaver is a combination startup document and control 
panel device that protects your hard disk by creating a file that 
contains details of all the applications, documents, and folders on 
your hard disk. As long as the file is present and up to date, For
mat Recover and UnErase can use it to restore accidentally lost 
data. Every time you throw a file into the Trash, eject a disk, or 
shutdown your Mac, FileSaver takes a "snapshot" of your disk. 
FileSaver also protects the Finder's Get Info comments when you 
rebuild the desktop. If FileSaver is already installed on your Mac, 
then just after the Welcome to Macintosh message (when you re
start), you will see the FileSaver icon at the bottom of your screen. 

You have to configure and activate FileSaver before you can use it 
to full advantage. 



CONFIGURING FILESAVER 
If you used the Install option in the Norton Installer, you already 
have FileSaver loaded into your startup System folder; however, if 
you used the Installer Customize option, FileSaver may not be 
present. 

If you didn't install FileSaver during the initial. installation, copy 
the FileSaver document to your System folder, and then activate 
FileSaver by restarting your Mac. To configure FileSaver, choose 
the Control Panel from the Apple menu and click on the FileSaver 
icon. You will see the FileSaver window as shown in Figure 4.1. 

The FileSaver window contains three sets of radio buttons, a slide 
bar, a Drive button you can use to change drives, and a checkbox. 
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The radio buttons are used as follows: 

• Save Finder's "Get Info" Comments. If you turn this selec
tion on, the Finder's comments (that are stored in the Get 
Info window and are viewed through the Get Info selection 
in the File menu) are protected and will not be lost the next 
time you rebuild the desktop. 

• Save Format Recover and UnErase Info. Tum this selection 
on to store information that Format Recover and UnErase 
can use in recovering unintentionally removed files or an 
accidentally reformatted hard disk. 

• FileSaver. This radio button turns FileS aver on or off. 

The slide bar lets you choose the number of files you want File
Saver to remember, from a minimum of no files to a maximum of 
500 files. The greater the number of files you choose to protect, 
the larger the amount of disk space FileSaver will need. A total 
of between 200 and 400 seems reasonable; any more than this 
and the erased files may be overwritten by other more recently 
erased files. 

The Show Icon at Startup checkbox at the bottom of the window 
determines whether the FileSaver icon is shown on the screen dur
ing a restart. Click on the box to choose to show the icon at 
startup. 

If you want to install FileSaver protection on another disk, click 
on the Drive button to change to the next drive. 

When you have finished making your selections, click on the Save 
button to create the FileSaver protection file. 



FILESAVER, 
FORMAT RECOVER, AND UNERASE 
If you accidentally reformat your hard disk, Format Recover uses 
FileSaver's stored information to recover your files and folders. 
Remember that you cannot use Format Recover to unformat 
floppy disks. Because the initialization (formatting) process on the 
Mac completely erases a floppy disk, Format Recover can only 
work with hard disks. Similarly, FileSaver cannot protect your 
hard disk against low-level formatting programs like those rou
tinely provided by hard disk manufacturers. 

In addition, UnErase uses the information stored by FileSaver to 
recover deleted files, particularly files that have become frag
mented into several small discontinuous pieces. 

For more information on Format Recover, see Step 12; for more 
information on UnErase, see Steps 13, 14, and 15. 

Although the combination of FileSaver with UnErase and For
mat Recover is a powerful one and can provide a high degree of 
protection, you should still continue to make regular backups 
of your files. 
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Using Directory 
Assistance 

Directory Assistance is a startup document that changes the way 
the Open, Save, and Save As dialog boxes look when you are 
working with files. There are several features that allow you to 
find or delete files, create new folders, and change drives; and 
there are two pop-up menus that contain File and View com
mands. In other words, you have much of the capability of the 
Finder right inside your application program, which is often where 
you need it. 

The Norton Installer copies Directory Assistance into the system 
folder on your startup disk; remember that you must restart your 
Macintosh to activate Directory Assistance. 

Directory Assistance is not compatible with Apple System 4.2 and 
has been disabled from the following applications and desk acces
sories because of compatibility problems: Cricket Draw, Cricket 
Graph, DiskTop, and SoundEdit. There may also be problems with 
On Cue and the shareware program Boomerang. 



USING THE FILE MENU 
After you ·have launched an application program, click on Open or 
Save As in the File menu, and you will see the Directory Assis
tance window as Figure 5.1 shows. 

If you double-click on a folder in this window, Directory Assis
tance opens that folder. Directory Assistance also remembers 
which folder you were in last time you opened or saved a docu
ment. It even remembers how you set up your favorite selections 
in the View menu. 

The File menu has the following commands: 

• New Folder (Command-N) creates a new folder on the 
selected disk. 
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• Get Info (Command-I) provides information on the 
selected file or folder. 

• Duplicate (Command-D) lets you duplicate the selected file 
or folder. 

• Delete allows you to delete a file or folder. A dialog box 
opens asking if you are sure that you want to make the 
deletion (unless you've selected an empty folder); click on 
Cancel if you change your mind, or click on Delete to 
throw the file away. Hold down the Option key when you 
select Delete if you want to prevent the verify delete box 
from appearing. Use this key combination with caution 
because there is no second chance; the file is deleted 
immediately. 

• Find (Command-F) allows you to search for a particular 
folder or to search a set of folders for a specific file name. 
Enter the name you are looking for into the Find What 
dialog box, imd click on OK. When Directory Assistance 
finds the file or folder, it is listed in the main window 
between the File and the View menus. 

• Find Again (Command-A) continues the search for the file 
or folder after Find located the first occurrence. 

• About shows you the usual Directory Assistance 
information. 

USING THE VIEW MENU 
You can use the selections in the View menu to change the way 
that files and folders are displayed in the Directory Assistance 
window as follows: 

• by Name arranges files and folders in alphabetical order by 
name. 



• by Date arranges the folders and documents in chronologi
cal order. The date on a document indicates the last time 
that it was modified or changed, and the date on a folder 
indicates the last time that a document inside the folder was 
changed in some way. With by Date selected, if you click 
on a file or folder in the Directory Assistance window, you 
will see the appropriate date and time shown at the bottom 
of the window. 

• by Size lists your documents and folders by size, largest 
first. If you click on a document or an application in the 
Directory Assistance window when you have by Size 
selected, you will see the size of the file in bytes at the 
bottom of the window. If you click on a folder, you will 
see a count of the number of items in the folder at the 
bottom of the screen. 

• Folders First lists your folders together followed by your 
files. 

• Folders Last lists files grouped together followed by your 
folders. To return to the normal way of listing files and 
folders (that is, in alphabetical order of files and folders 
together), reselect the Folders First or Files First selection 
you had made. Reselecting your choice toggles it off again, 
and this restores the listing to normal alphabetical order. 

KEYBOARD SHORTCUTS 
There are several different keyboard shortcuts you can use with 
Directory Assistance to save you time and keystrokes. 

• If you want to turn Directory Assistance off for a moment 
so you can access the File menu in the usual way, hold 
down the Option key as you choose Open or Save As from 
the File menu. This turns Directory Assistance off until the 
next time you access the File menu. 
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• If you are adding to a file such as a word processor docu
ment and you want to save the new file on top of the old 
one, you can press Y from the keyboard instead of clicking 
on the Yes box in the Replace existing dialog box. You can 
also hold down the Option key when you click on the Save 
button to avoid the Replace existing dialog box altogether. 

• When you use Save and you want to find a file with the 
same name as the file you are saving (so you can avoid 
using the same name), hold down the Option key as you 
select Find. The name of the file you are about to save will 
be entered automatically into the Find dialog box for you. 

You can permanently turn Directory Assistance off inside a spe
cific application if you add that application program's Creator 
type to the APP# list in the Directory Assistance resource fork. 
The Creator type is a four-letter code that identifies the application 
originally used to create the document. This is an advanced tech
nique usually performed with ResEdit or a similar resource editor. 
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Using 
Disk Light 

DiskLight is another of the startup document and control panel 
devices included in the Norton Utilities package. DiskLight allows 
you to monitor disk access even when you cannot see the disk in 
question. This is particularly useful if your hard disk is an external 
drive. 

The Norton Installer copies the DiskLight startup document/con
trol panel device into the system folder on your startup disk. You 
must restart your Macintosh and configure the program before 
DiskLight can become active. 

CONFIGURING AND USING DISKLIGHT 
After you have restarted your Mac, choose the Control Panel from 
the Apple menu, scroll down the list of icons, and click on the 
DiskLight icon. You will see the DiskLight configuration window, 
as shown in Figure 6.1 . 
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• Figure 6.1: Use the Disk Light configuration window to set up DfskLfght 

There are three radio buttons at the top of the window, a set of 
icon descriptions in the center, and a checkbox at the bottom. 

Choose one of the radio buttons to select where you want the 
DiskLight icon to appear on the menu line: 

• Left positions the icon to the left of the Apple menu. 

• Off turns DiskLight off so that it is not used. The next time 
you restart your Mac, you will briefly see the DiskLight 
icon with an X through it at the bottom of the screen. 

• Right displays the DiskLight icon to the far right of the 
menu line. This is probably the most appropriate place to 
put the icon for most application programs. 

After you make your selection, the DiskLight icon is shown on the 
grayed-out menu bar towards the top of the control panel window, 
showing you how it will look in normal operation. 
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The DiskLight icon can take two forms: 

• Hard disk. A small rounded rectangle denotes a hard disk. 

• Floppy Disk. A small picture of a Macintosh floppy disk 
indicates a floppy disk. 

If you read from the drive, the appropriate disk icon flashes on the 
menu bar at the top of the screen. If you write to the drive, a s111all 
w is shown underneath the flashing drive icon. 

Use the checkbox at the bottom of the window to choose whether 
you want to see the DiskLight icon displayed each time you start 
or restart your Macintosh. 

When you have configured DiskLight, click on the close box to 
close the control panel. 

If you want to turn DiskLight off when you next use your Macin
tosh, hold down the Option key as the Macintosh starts. The 
DiskLight icon at startup shows an X through it to indicate that it 
is not installed and is not being used during this session. This does 
not affect the default DiskLight settings. 
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Finding Files 
Quickly 

Fast Find is a desk accessory that allows you to search for files 
and folders very quickly. Once you have found a file, you can 
look at it using Fast Find, and you can even launch the application 
program that made the file if you wish. 

The Norton Installer copies Fast Find into your system folder on 
your startup disk during the installation of the rest of the utilities. 
Alternatively, you can install the program by using Font[DA 
Mover or a resource utility like Suitcase II. 

To start Fast Find, choose the Apple menu, and select Fast Find. 
You will see a window similar to the one shown in Figure 7 .1 . 

All the disk drives currently available for searching are shown at 
the top of the window. Click on the drive you want to look at. 

Fast Find can display the icons of up to three disk drives (vol
umes) at a time; click on the arrows or use the Tab key to see 



• * File Edit Ulcw Speclel Fos t Find 

ID 

8 
-lliiiiiiiD 

Search For: I 
~ ttorton UHlitlu 

D Norton CommtntS•vtr D•t• 

D Norton rlhS•vtr D11h 

D Ncr' ton Votut't'l45avtr IMtx 

CJ Uorton Ut llltlu 

D t•orlon VobMS.-vtr D•h 

Crnhd : W'td, Jul I I , 1990 
H odif-led: 'w'td, J\1'\ 12,1991 

Kind: docr..mtnt 
Siu: 306,799 byhs 

Fost Find'" 

~ ~ll..,.dDisk 

13 :00 ~ eg Uorton Utllltlu 
16

'
47 D D Uorl onUtiHtlt~Ht\> 

• Figure 7.1: The main Fast Find window 

other volumes if you have more than three. When you have se
lected one drive, you can hold down the Shift key while clicking 
on drives to extend the search to a second or third drive. Choose 
Select All Drives (Command-A) from the Fast Find menu to ex
tend the search to al l the drives available. 

FINDING FILES 
Type in all or part of the fi le or folder name you want to search 
for. The search is not case sensi tive. For example, norton is 
treated the same as NORTON and Norton. In fact as Figure 7.1 
shows, when looking for all the Norton Utilities files, it is suffi
cient to enter the abbreviation nort. Press Enter or click on the 
running man icon to start the search. 

The search begins with the disk represented by the leftmost icon 
in the window and then moves to each subsequent disk. As the 
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disk volumes are searched and the running man runs, search prog
ress is shown by the horizontal bar. 

This indicates how much of the disk has been searched and how 
much remains. The number of files and folders found matching 
the search criteria is shown immediately to the left of this bar, and 
this number is updated as new matches are found throughout the 
search. You can click on the stop icon (the raised hand) any time 
you want to stop the search. 

The files found are listed in the central part of the window, and 
their icons indicate whether they are documents, applications, or 
folders. 

When the search is complete, Fast Find plays a chime to let you 
know that it is finished. You can click on the files in this window 
to display more information about them in the bottom two boxes 
in the window. At the bottom left, you can see the create and mod
ify information on the file, as well as information on the file kind 
and size. If you choose the Norton Utilities Help file, you will see 
information similar to that shown at the bottom of Figure 7 .1. 
Over in the right box you can see a picture of exactly where this 
file or folder fits into the overall structure of your disk. As you se
lect different files or folders in the main scrollable part of the win
dow, the information in the bottom two boxes changes to reflect 
the new files. 

BROWSING THROUGH FILES 
When Fast Find has found the file you are looking for, you can 
browse through its contents without launching the original appli
cation program that created the file. You can even look at a docu
ment whose application program is "busy or missing." 

Finding Files 



To look at a document, frrst click on the file you are interested in, 
and then click on the magnifying glass icon in the lower left box 
of the window. You can also select View document (Command-F) 
from the Fast Find menu to do the same thing. 

If you insert the Norton InstaUer disk into your floppy disk drive 
and then use Fast Find to locate all the files on this disk with the 
word notes in their names, you will find three files: Accessory 
Notes, Installer Notes, and Disk Repair Notes. Click on Acces
sory Notes, and then click on the magnifying glass icon to display 
the contents of the file as text. The next window displays the first 
32K of the file, as Figure 7.2 shows. 

Use the scroll bars to move through the file, and click on Done 
when you are through. 
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If you look at files of different types using the View document se
lection (Command-F) in the Fast Find menu, they may not always 
look just as you expect them to. For example, if you look at the 
Norton Utilities file, you will see some things that you recognize 
and much that you won't. This is because Fast Find ~isplays the 
files as text files, and sometimes files contain control information 
that was never intended to be read as text. If you look at an appli
cation program file using Fast Find, the characters that cannot be 
displayed are represented on the screen by periods. 

One of the main benefits of this part of Fast Find is that you can 
use it to ensure that you have found the file you want to work 
with before you go to all the trouble of launching the application 
program. 

USING THE FAST FILE MENU 
There are several other important tasks you can complete with 
Fast Find, including searching through folders rather than through 
complete disks and moving documents to the desktop so that you 
can work on them. These features are all accessed from the Fast 
Find menu. Use the About Fast Find command in the Fast Find 
menu to look at the version number and find out who wrote 
Fast Find. 

Searching Folders 
If you know roughly where a file is and you just want to search 
through a specific folder, use Search Folder (Command-S) from 
the Fast Find menu. 

The search window shown in Figure 7.3 opens, listing the folders 
(but not the files) on the selected disk or disks. 

Finding Files 
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There are several radio buttons available on this window: 

• Eject If the Eject button is not dimmed, you can use it to 
eject the selected volume. If it is dimmed, you cannot 
use it. 

• Drive: Click on Drive to change to another disk drive. 

• Open: Choose Open to see other folders inside the folder 
you have chosen. 

• Cancel: Click on Cancel to abort the current operation. 

• Select: Choose Select to confirm your choice of folder. 

You can use the File and View menus of Directory Assistance, if 
you wish, as I described in Step 5. 

Click on the folder you want to search, and then click on Select. 
When you return to the main Fast Find window, the icon of the 
folder you selected replaces the disk icon that was previously 
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shown at the top of the window. Change the Search For text if you 
want to, and then click on the running man or press Enter to exe
cute the search. Just as before, the files corresponding to the 
search criteria are listed in the scrollable window one by one as 
they are located. If you click on one, you will see the file informa
tion shown in the two boxes at the bottom of the window. 

If you select a folder, the Search Folder entry in the Fast Find 
menu changes to Search Drives (Command-S). Now if you choose 
Search Drives, Fast Find replaces the folder icon at the top of the 
screen with disk drive icons. These two options allow you to 
toggle between folders and disk drives. 

Moving Files to the Desktop 
Select a file or folder in the scrollable window, and then choose 
Move to Desktop (Command-M) from the Fast Find menu to 
move the file or folder to the desktop, no matter where the file 
was originally located. 

This is a particularly useful feature that lets you move files or 
folders to the desktop so that you can perform houskeeping tasks 
on them. You can use the Put Away command from the File menu 
to put the files or folders back in their original location again 
when you are finished with them. 

Launching an Application 
To open a document or launch an application, double-click on its 
name in the scrollable window or use Open application (Com
mand-O) from the Fast Find menu. 

In most cases, Fast Find recognizes the application, closes Fast 
Find, and then opens the application. In certain rare cases, 



Fast Find may not be able to open the application, in which case 
you will be asked to open it by the usual methods. 

Choose Quit (Command-Q) from the Fast Find menu, or click on 
the close box to exit Fast Find and return to the Finder or to the 
application you were running before you opened Fast Find. 
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Using 
KeyFinder 

KeyFinder is a desk accessory you can use to display all the char
acters available in a specific font on the screen at the same time. If 
you have ever wanted to generate a foreign language character 
such as the English pound sterling symbol (£) or the German f3 
symbol (used to represent ss), KeyFinder shows which keystrokes 
generate each of the characters. If you are·a programmer, you can 
use KeyFinder to show you the decimal or hexadecimal ASCII 
(American Standard Code for Information Interchange) equiva
lents of the characters. If you have worked with Apple's Key Caps 
desk accessory, note that you do not have to hold down modifier 
keys (for example, Shift and Option) to generate certain characters 
with Key Finder; in fact, Key Finder can make some characters that 
Key Caps cannot 

The Norton Installer copies Keyfinder into the system folder on 
your startup disk. If you want to install it yourself, use Font/DA 
Mover or a resource utility such as Suitcase II. 



THE KEYFINDER WINDOW 
Select KeyFinder from the Apple menu, and you will see the win
dow shown in Figure 8.1. 

A 16-by-16-character matrix is shown on the left side of the win
dow. This matrix displays all the characters available in a particu
lar font. Blank cells represent nondisplayable characters such as 
the first few ASCII characters, including carriage return, line feed , 
and so on. Cells conta ining an open rectangle do not have a char
acter assigned in that particular font, so no character is displayed; 
this will change from font to font. 

To move to another character in the matrix, just move the mouse 
and click on the character you want to look at. You can also use 
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• Figure 8.1: The KeyFinder window shows all the characters available in a 
specific font 
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the Option key with the arrow keys to move around inside the 
matrix. 

At the top right of the window, there is an enJarged image of the 
character shown below the keystrokes used to generate the charac
ter. The information in the keystroke and character box changes to 
reflect your new selections as you move from character to charac
ter in the matrix. 

Below this box is a list of all the fonts loaded onto your Macin
tosh. Use the scroll bar in the usual way to move through this list. 
Alternatively, you can use the Command key with i and J, to 
scroll through the list of fonts. As you change to another font, the 
characters in the 16-by-16-cell matrix all change to reflect the new 
font. Try changing from Chicago to London or to Mobile to see 
how the characters change. 

FINDING AND 
USING SPECIAL CHARACTERS 
To find the keystrokes that will generate a specific character, fol
low these steps: 

I. Select the font by clicking on the font name in the scrol
lable list. 

2. Find the character you are curious about in the 16-by-16-
cell matrix, and click on it with the mouse. 

3. The keystrokes that will generate the character in question 
are shown in the box at the top right. 

To check that a particular keystroke sequence generates the char
acter you want, just type the keystrokes from the keyboard. The 
highlight will move to the new location in the 16-by-16-cell ma
trix, no matter where the cursor was originally located. 



Keys that must be used in combination are shown close together 
in the Keystroke display; keys that must be used in sequence are 
shown with wider separations between them. For example, if you 
are using the default Chicago font, to generate the English pound 
sterling character, use the Option key and 3 together; for the Ger
man 13 character, use the Option key and S together. 

With more complex examples, such as the German ti (u with an 
umlaut above), you must type Option and u at the same time, fol
lowed by another u. In the Keystroke display, the second u is 
spaced slightly apart from the leading keystrokes. 

It is not possible to enter ASCII character codes directly into this 
display to generate the equivalent character; selecting a cell or 
typing keys from the keyboard are the only ways to interact with 
Key Finder. 

USING THE KEVFINDER MENU 
There are several selections in the KeyFinder menu to help you 
work with KeyFinder, including About KeyFinder, which shows 
you who designed the program and the current version number. 
The other items in the Key Finder menu are as follows: 

• Swap Orientation (Command-O). The cells in the Key
finder display are usual ly ordered from top left to bottom 
right as horizontal rows of increasing ASCII character code 
numbers. Use Swap Orientation to change these rows to 
vertical columns. 

• Real Font Size (Command-S). The character shown in the 
box at the top right of the Key Finder window is enlarged so 
you can see the character in detail. Use Real Font Size if 
you want to see the character in its usual size. 
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• Show ASCII (Command-A). The low-order ASCll charac
ters, up to decimal 32, usually do not have a displayable 
character associated with them and are usually shown in 
the matrix as open rectangles or as open cells. If you turn 
on Show ASCII, a two- or three-letter abbreviation is 
shown in the cell instead. For example, carriage return 
(ASCII 13) is labeled CR, and the bell (ASCII 7) is 
labeled BEL. 

• Programmer Mode (Command-M). The Programmer Mode 
adds hexadecimal guides to the top and the left sides of the 
cell matrix so that you can locate a specific ASCII charac
ter and determine its hex equivalent quickly and easily. 

With the cell table ordered in vertical rows, type Command-M, or 
select Programmer Mode from the KeyFinder menu. Then type 
Command-A, or click on Show ASCH from the KeyFinder menu. 
Now the low-order ASCll characters are visible, and the hexadeci
mal guides appear around the edges of the cell window. If you se
lect the Chicago font, you will see that the KeyFinder window 
looks like Figure 8.2. 

To find the hex value of a character, take the hex guide number 
from the left margin, and add it to the hex guide from the top. For 
example, carriage return is OD in hex, and the numeral 0 is 30 
in hex. 

The box at the top right of the Key Finder window changes in Pro
grammer Mode to show more information, including the character 
itself, the keystrokes you must type to generate it, its ASCII name, 
and its ASCII equivalent in decimal, hexadecimal, and octal. For 
example, the English pound sterling character, £, is generated 
when you press Option and 3 from the keyboard. This character is 
163 in decimal in the Chicago font and is equivalent to A3 in hex 
and to 243 in octal. Real Font Size is not available in Programmer 
Mode. 
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• Figure 8.2: KeyFinder Programmer Mode 

Additional items in the Key Finder menu are as follows: 

• Text Edit (Command-T). When you select Text Edit from 
the KeyFinder menu, an additional box opens between the 
keystroke and character box and the scrollable list of fonts. 
You can enter a string of characters into this box, rather 
than just one character, and copy them all to the Clipboard. 

• Page Setup. Page Setup opens the usual setup dialog box 
for your printer. Make the selections you need before 
choosing the next option in the menu, Print. 

If you are using a Laser Writer, clear the Font Substitution 
checkbox in Page Setup to avoid New York, Geneva, and 
Monaco being replaced by Times, Helvetica, and Courier, 
respectively. 

• Print (Command-P). Choose Print when you are ready to 
print out a page of KeyFinder information. Use Page Setup 
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ftrst to establish all the key parameters for your printer. 

• Quit (Command-Q). Use Quit to close Key Finder and 
return to the Finder or to the application you were working 
with before you opened KeyFinder. 

When you close KeyFinder, it remembers the options you 
selected from the KeyFinder menu and will make sure they 
are selected when you open KeyFinder again. 

USING THE 
EDIT MENU WITH THE CLIPBOARD 
Once you have found a particular character in KeyFinder, you can 
transfer it to another application program by using the Clipboard. 
The main selections from the Edit menu used to move text onto 
the Clipboard are as follows: 

• Cut (Command-X). You must select Text Edit from the 
KeyFinder menu before you can use Cut to cut text and 
place it on the Clipboard. In the text box that is in the 
center of the Key Finder window, collect the characters you 
want to cut the Clipboard, and then select the characters by 
dragging the mouse over them. Once the charac ters have 
been selected, choose Cut (Command-X) from the Edit 
menu. The original characters in the KeyFinder text box 
will disappear and move onto the Clipboard. Remember 
that the Clipboard can hold only one item at a time. This 
cut text will stay on the Clipboard unti l it too is replaced. 

When you paste the text into your application program 
from the Clipboard, remember that the results will depend 
on the font chosen in the application program. 

• Copy (Command-C). The Copy command works just like 
the Cut command except that the text is not removed from 



the KeyFinder text window when the copy is complete. 

• Paste (Command-V). You can move characters from the 
Clipboard back into KeyFinder again to determine the 
keystrokes that generated the character. If Text Edit in the 
Key Finder menu is enabled, you can transfer a sequence of 
characters from the Clipboard; if Text Edit is not selected, 
you can transfer only the last character on the Clipboard. 
To see the keystrokes that generated a character brought in 
from another application program via the Clipboard, place 
the cursor to the right of the character in the text box, and 
click on the mouse while you also press the Command key. 
The keystrokes used to generate the character are shown in 
the upper right box of the KeyFinder window. 

To see what the imported characters look like in another font, 
paste the characters into the text box from the Clipboard, and then 
select the font you want from the scrollable font list. 

The text box display will be converted to the new font along with 
the rest of the 16-by-16-character matrix. 

You can use Show Clipboard from the Edit menu to look at the 
contents of the Clipboard at any time. Remember that this com
mand is not available if you are using the Multi Finder. 
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• 

-~· Customizing Your 
Desktop 

• • • • • • • • • • • 

Layout Plus is an application program that allows you to custom
ize the way that the Finder displays the desktop. You can change 
font sizes and types, icon spacing and color, and other desktop 
attributes. Layout Plus is based on a freeware program called Lay
out, originally written by Michael O'Connor. 

The Norton Installer copies Layout Plus from the distribution disk 
into the Norton Utilities folder on your hard disk. You can launch 
Layout Plus by double-clicking on its icon in the Norton Folder, 
or you can select it from the Utilities menu inside the main Norton 
Utilities application program. 

Remember that the full Norton help system is avai lable to you 
from inside this application; review Step 3 for a complete descrip
tion of how to use help. 



CUSTOMIZING YOUR 
DESKTOP WITH LAYOUT PLUS 
You use Layout Plus when you want to change the way the Finder 
displays the desktop. You can change the icon spacing horizon
tally or vertically, you can change the font used for folders and 
document names inside folders, and you can even change the col
ors the desktop uses if your Macintosh displays colors. 

You configure the Finder by using the menus in Layout Plus, and 
the Special menu allows you to set most of the Layout Plus con
figuration parameters. 

WORKING WITH THE SPECIAL MENU 
The first item in the Special menu is the Options selection. When 
you select Options, you will see a window like that shown in Fig
ure 9.1. 

There are several checkboxes and radio buttons in this window 
that control how the Finder works and looks in its day-to-day op
erations. If there is an X in the box, the option is selected. 

• Animation. When this selection is checked, the Finder 
zooms windows when they are opened. If you cancel the 
check, the Finder will not zoom the windows and will 
work much more quickly as a result. 

• Drag to Grid. When this is not checked, you can place an 
icon anywhere you like on the desktop. If you check this 
box, then when you move an icon, it is placed on an invis
ible grid automatically, without having to do a cleanup. 

• Trash Warning. This box is normally checked, which 
causes the Finder to provide a warning dialog box if you 
try to throw an application or a system file into the trash. If 
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this selection is not checked, the Finder does not open the 
dialog box before trashing the file. As you can see, leaving 
this box unchecked can be somewhat dangerous. 

• Title Bar Click. If you check this selection, you can switch 
the parent window of the current window to the front when 
you double-click on the current window's title bar. 

• Show Hardware Icons. This option replaces the disk icons 
on the desktop with icons representing the drives them
selves. For example, the normal floppy disk icon is re
placed by a small Macintosh icon. 

• Copy Settings Too. If you check this option, all the folder 
attributes, including size, color, and view are transferred 
when you copy a folder. 

• New Folder Settings. If you check this option, all the attri
butes of the parent folder are copied when you create a new 
folder. This may have unexpected results if you create a 
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new folder on a file server because the Appleshare permis
sions are also duplicated to the new folder. If you do not 
own the parent folder, you may not be able to look at, 
delete, or use the copy. 

There are several other settings you can configure in the lower 
half of the Options window. 

• Pause before watch. This setting allows you to choose the 
length of time that must elapse before the Finder displays 
the busy wristwatch icon. This item is specified in 60ths of 
a second, but if you make it too short, the cursor will be 
constantly changing shape from the arrow to the wristwatch 
and back again, and wi ll cease to be of any value. The 
default is 120. 

• Maximum open windows. This setting governs the number 
of windows that the Finder can open at one time. Increas
ing this number from the default 13 makes the Finder use 
more memory. If you are using MultiFinder, you may well 
have to increase its memory aJiocation. 

• Color Icon Style. This setting allows you to select whether 
your desktop icons are bordered with color or are fi lled in. 

• Color. Use this column of color bars to choose the colors 
that appear in the color menu in the Finder. This option 
appears only if you have installed color resolution. 

If you want to restore the default Finder settings, click on De
faults , and if you want to abort the Options selections, click on 
Cancel. Otherwise click on OK to confirm your choice of settings. 
To save your settings, remember to use Save from the File menu. 

The other selections in the Special menu determine how text in
formation is displayed on the desktop. The choices are as fo llows: 

• Font. Click on a font from the list showing the fonts avail
able in the current system. By changing to another font, 
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you can alter the way the Finder displays most text, includ
ing icon titles and the information printed by the Finder 
when it creates a Print Directory. 

• Size. Next choose the size of the letters you want to use. If 
you ever have difficulty reading the desktop information, 
choose one of the larger type sizes. 

• Style. Finally, you can choose a style for the lettering as 
long as you are using the Text View. You can choose from 
or combine bold, italic, underline, outline, and drop 
shadow. This also applies to the view heading, Name, or 
Kind, depending on which type of view you are using. 

THE FILE MENU 
The options in the File menu are as follows: 

• Open. Use Open (Command-O) to select the Finder you 
want to configure. A standard dialog box opens unless you 
are using Directory Assistance, in which case the Directory 
Assistance dialog box opens. If you are already working 
with a Finder, Layout Plus first asks if you want to save 
those changes. 

• Save. When you have completed your configuration, use 
Save (Command-S) to store your changes in the Finder. 

• Revert. If you have made changes and then you decide that 
you liked the Finder better the way it was, use Revert 
(Command-R) to undo the last set of changes and reset the 
Finder. 

• Restore All Defaults. This option removes all of the Layout 
Plus changes made to a Finder and restores the Finder back 
into its original configuration. Several of the Layout Plus 
options can be individually reset back to their original 
state. 
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• Copy From. Use this option to copy the characteristics of 
one Finder to another Finder. A dialog box opens to allow 
you to select another Finder. When you select a Finder in 
this box, its characteristics are copied to the Finder you are 
working on. 

• Quit. Use Quit (Command-Q) to exit Layout Plus. If you 
have made changes and forgotten to save them, a dialog 
box opens asking if you want to save the changes before 
you exit. 

THE EDIT MENU 
All of the commands in the Edit menu are grayed out except for 
Undo. Undo (Command-Z) removes the effect of the last selection 
you made. As soon as you click on Undo, it changes to Redo, just 
in case you change your mind and want to undo the last undo. 

THE VIEW MENU 
You can also use many of the selections available in the View 
menu to change the way in which the Finder displays information 
on the desktop. 

• by Small Icon (Command-M). Use this selection to display 
items on the desktop as smaH icons. Figure 9.2 shows the 
Layout Plus window displaying regular-sized icons 

The document icons shown in the Layout Plus window are not 
real icons; they are example icons used to show you how the icon 
spacing will look on the desktop when you have finished using 
Layout Plus. 

Two of these dummy icons have special arrow symbols to help 
you select the best icon spacing for your desktop. You can change 
the horizontal or vertical arrangement of the document icons by 
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• Figure 9.2: The Layout Plus icon window 

dragging the icons with the arrows. By carefully arranging the 
icons, you can prevent folders with especially long names from 
overwriting their neighbors. Also, as you change the icon spacing, 
you can make either more or fewer icons fit into the same win
dow space. 

The Finder uses this new icon spacing when you issue a Clean Up 
command, when you create a new folder, and when you drag a 
folder to a new location and you have turned on Drag to Grid. 

The other options on the View menu are as follows: 

• by Icon (Command-I). This is very similar to the previ
ous choice, only the icons are the regular size. Drag the 
document shown with the diagonal arrows to move the 
documents laterally, and drag the document with the verti
cal arrows to reposition the documents vertically. Again, 
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the Finder will use this new spacing when it needs to place 
an icon. 

• by Text (Command-T). Use by Text to list the files and 
folders by name. Click on the large arrows at the bottom of 
this text window, shown in Figure 9.3, to left or right jus
tify the information displayed in the corresponding column. 

Drag the dotted vertical lines that separate each set of text to make 
the Name, Size, Kind, or Last Modified columns larger or smaller. 
These column sizes are also used when the Finder lists the con
tents of a folder as a Print Directory. The Finder does not show 
text if it is too wide to fit into the column; instead, an ellipsis in 
the column shows that text has been truncated and is hidden from 
view. You cannot change the order of these columns, insert a new 
column, or delete any of the existing columns. 

• Change Window Size. You can use this selection to choose 
the default size and position of any new window opened by 
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• Figure 9.3: The View as Text window lists files and folders by name 
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the Finder. You can reposition the window by dragging the 
header bar to a new location on the screen, and you can 
drag the size box in the bottom right comer to change the 
size of the window. 

• Default View. Use this selection to choose how the infor
mation in a new window will be displayed. Choose the 
view you like best from: 

• Small Icon 

• Icon 

• Name 

• Date 

• Size 

• Kind 

• Use Default Spacing. If you are using the icon view, this 
selection is Use Default Spacing; if you are using the text 
view, it becomes Use Default Tabs; if you have changed 
the default window size with Change Window Size, it 
becomes Use Default Window Size. In all three of these 
cases , the Use Default command cancels your previous 
selection of icon spacing, tabs, or a new window size or 
location and returns to the Finder default. 

• Lock To Grid. With this selection checked, any adjustments 
you make to the icon or small icon spacing are snapped to 
an invisible grid. If you want to be able to make small 
adjustments to icons on the desktop, make sure this selec
tion is turned off. (This command toggles on and off.) 

• Date Format. You can make Layout Plus display the date in 
one of three formats. For example, a Tuesday in June could 
be displayed as 6/25/91, as Tuesday, June 25, 1991, or as 
Tue, Jun 25, 1991. When you are viewing by Text, you can 



' 

double-click in the Last Modified column in Layout Plus to 
cycle through each of these date formats until you find the 
one that you like the best. 

With all this capability available to you in Layout Plus, you can 
easily design a desktop tailored to your own needs. 

When you have completed all your changes, remember to save 
these settings with Save (Command-S) in the File menu. 

If you want to use one of the other Norton Utilities, make your 
selection from the Utilities menu; otherwise, choose Quit (Com
mand-Q) in the File menu to return to the Finder. 
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Using the Norton 
Disk Doctor 

• • • • • • • • • • • 

What can you do if your disk contains files or folders that you 
can't read or your startup disk won't start? You can use the Norton 
Disk Doctor to diagnose the problem and fix the unreadable files. 
The Norton Disk Doctor can find and fix almost any logical or 
high-level physical errors on your hard and floppy disks. The Nor
ton Disk Doctor is very easy to use, in most cases is completely 
automatic, and certainly does not require large amounts of arcane 
knowledge about sectors and disk drive internals. 

The Norton Disk Doctor is designed to work with the Macintosh 
Hierarchical File System (HFS) and will not work on the Macin
tosh File System (MFS) used by 400K floppy disks for 128K and 
512K Macintoshes. 

I do not go into great detail about the cause or nature of disk er
rors in this Step. Suffice it to say, you should launch the Norton 



Disk Doctor after your Macintosh reports a disk error or doesn't 
start. 

The Norton Disk Doctor will not fix disk problems over a net
work; however, you can use it to look for file-related problems. To 
repair an error on the file server, you must install the Norton Utili
ties on the file server; this wi ll probably require that you shut 
down the network first. 

LAUNCHING THE NORTON DISK DOCTOR 
If your Macintosh will not start from your usual startup disk, and 
you see the missing disk icon (a floppy disk with a flashing X 
through it) or the Sad Mac icon, you must launch the Norton 
Disk Doctor from the red Emergency disk or a backup copy of 
this disk. 

If your Macintosh will start, but you are experiencing problems 
with files or folders after it has started running, you can run the 
Norton Disk Doctor from either the red Emergency disk or di
rectly from your hard disk. 

When you launch the Norton Utilities, you will see icons for the 
Norton Disk Doctor, UnErase, Format Recover, and Speed Disk in 
the startup window. Click on one of these icons to start the appro
priate program running. You can also start one of these same four 
utilities by selecting them by name from the Utilities menu. Two 
other utilities are also avai lable from this menu: the Norton Disk 
Editor and Layout Plus. 

Click on the Norton Disk Doctor icon, or select it from the Utili
ties menu. 
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DIAGNOSING PROBLEMS 
WITH NORTON DISK DOCTOR 
A dialog box opens asking which of the disks connected to your 
Macintosh you wish to work with. Click on Drive to change to 
the next disk, and then click on Open to select the drive. You will 
see the Norton Disk Doctor window open next, as shown in Fig
ure 10.1. 

The Norton Disk Doctor performs six tests in diagnosing and re
pairing a disk as this window shows: 

• Checking Volume Info. During this step the Norton Disk 
Doctor makes sure that a disk, or volume, can be mounted; 
that is, it checks that essential data can be loaded from the 
disk so that it can be displayed on the desktop. 
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• Figure 10.1: The Norton Disk Doctor main window shows the six main 
analyses performed on every disk 
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• Analyzing Directory. Next, all files and folders are checked 
to see that they can be opened. The Norton Disk Doctor 
fixes any folders that can't be opened. 

• Checking Hierarchy. All the directories are checked for 
consistent and correct information. 

• Checking Allocation. During this test, your disk is checked 
for areas on the disk that are assigned to more than one file 
at a time. These files are referred to as cross-linked files. 

• Looking for Lost Files. This part of the test looks for areas 
of the disk that are being used according to the bookkeep
ing information available but in actuality are not being used 
by any file. These areas are often known as "lost sectors." 

• Analyzing Files. Finally, every file on your disk is checked 
for damage, missing Finder icons, and several common 
viruses. This section of the tests can also locate duplicate 
copies of the Finder and the system. 

Click on Start to begin the analysis. The horizontal progress bar 
shows how things are proceeding, and you can click on Cancel if 
you want to halt the tests. As each part of the analysis is made, the 
border around the appropriate icon changes. During the last phase 
of these tests, you will see the name of the disk being tested fol
lowed by your folder names at the bottom left of this window. 
Underneath this information is the name of the f ile actually being 
tested right now. 

If the Norton Disk Doctor encounters a problem at any point in 
the tests, a window opens asking you if you want to fix the prob
lem. Some of the problems will be very serious and you should fix 
them right away; others will be less serious, but go ahead and 
fix them anyway. Figure 10.2 shows one of these problem win
dows for a problem found during the Analyzing Files part of 
the test. 
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• Figure 10.2: If the Norton Disk Doctor finds a problem, a window opens 
asking if you want to fix it 

Click on Yes to fix the problem, No to ignore the problem, or Quit 
to leave the Norton Disk Doctor and return to the main Norton 
Utilities startup window. 

Finally, when all the tests are complete, you will see a clipboard 
on the screen showing a short report on the health of your disk. 
Areas checked include the boot blocks, the volume info block, the 
volume bit map , the directory or folder layout, and the file 
structure. 

MAKING A PRINTED REPORT 
Click on Done to return to the main Norton Utilities startup win
dow, or if you want to see a more detailed report of the Norton 
Disk Doctor's findings, click on More Info to create a text report. 
A dialog box opens asking where you want to save the report. Part 
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• Figure 10.3: The Norton Disk Doctor can make a detailed text report of 
its findings 

of a Norton Disk Doctor report for a hard disk is shown in Fig
ure 10.3. 

The report is a text file, so you can use TeachText or your favorite 
word processor to look at it. The report is dated and contains the 
following major headings: 

• System Information includes the type of Macintosh and the 
amount of main memory. 

• System Area Status lists the areas checked, and if one or 
more parts were found to contain errors and were fixed. 

• Disk Statistics lists the size and type of the disk, the 
amount of space occupied by fi les and folders, and 
the amount of remaining free space. 

• Disk Technical Information includes disk initialization and 
last modification dates; a count of the allocation blocks, or 
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sectors, on the disk; and the starting sector numbers of the 
volume bit map. 

• File Status lists the total number of files and the number 
with resource forks. 

• System Folder Details lists all the cdevs and INITs on the 
disk giving names and version numbers. It also shows 
details of the system, Finder, and MultiFinder. 

• Summary. Ideally the summary indicates that your disk is 
now in good shape. 

If errors were found by the Norton Disk Doctor, they too are de
tailed under the appropriate heading in the report, along with an 
indication of whether they were fixed or not. 

If your disk exhibited multiple disk errors, you should run the 
Norton Disk Doctor a second time. It is entirely possible that an 
error fixed by the Norton Disk Doctor was masking a second error 
that it did not fix. A second run through your disk will find all of 
these hidden errors if there are any, and it certainly will not dam
age anything. 

LEAVING THE NORTON UTILITIES 
Select Quit (Command-Q) from the File menu to leave the Norton 
Utilities. Remember that there is no Finder on the red Emergency 
disk; choose Restart or Shut Down when quitting the Norton 
Utilities. 
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Recovering 
Damaged Disks 

Disk problems can take several different forms. For example, your 
startup disk might refuse to boot, causing the Sad Mac icon to 
appear on the screen. Perhaps you insert a disk you know con
tains important information and all you see on the screen is the 
message 

This disk is unreadable: Do you want to 
initialize it? 

The Norton Disk Doctor can help you in both of these cases. 

Remember that the red Emergency disk contains only the Norton 
Utilities application program and a system. It does not contain the 
Norton Help file, so the help system is not available to you when 
you are working from this disk. Proceed carefully. 



RECOVERING A DAMAGED HARD DISK 
If your Macintosh refuses to start from your hard disk, insert the 
red Emergency disk into the disk drive and turn on your Macin
tosh. Your Mac should start; load the Norton Utilities, go straight 
to the utility 's opening window, and click on the Norton Disk 
Doctor icon. When the Choose a volume to Diagnose dialog box 
opens, click on the Drive button (or type Command-D) until you 
see the name of your damaged startup disk, and then click on 
Open. 

If the name of your startup hard disk does not appear in the dialog 
box, click on Cancel and choose Quit from the File menu. Since 
there is no Finder on the red Emergency disk, a dialog box opens 
giving you the choice of Restart, ShutDown, or Cancel. Click on 
ShutDown, turn both your Macintosh and your hard disk off (es
pecially if you are working with an external drive), and check that 
all the cables and connectors are securely attached. 

Turn on the disk drive and let it run for a few minutes before you 
try to load the Norton Utilities from the red Emergency disk for a 
second time. If your Macintosh still refuses to start, you probably 
have a hardware problem, and you should contact your computer 
dealer's service department. 

After you click on the Open button in the Choose a volume to Di
agnose dialog box, the main Norton Disk Doctor window appears, 
showing the six main tests that will be run on your hard disk. 
Click on Start, and watch for prompts on the screen. 

As the Norton Disk Doctor runs the tests and finds problems, dia
log boxes open detailing what the program has found. You can 
choose to either fix or ignore the problem; however, you should 
follow the program's advice and let the Norton Disk Doctor fix all 
the problems that it finds. 
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When the Norton Disk Doctor finishes checking your hard disk, 
you will see a report card on the screen that details the areas of the 
disk that were checked. These include the boot blocks, the volume 
info block, the volume bit map, the directory layout, and the file 
structure. 

If you want to see a more detailed report on your hard disk, click 
on More Info to save the report to a file. Remember that there is 
no room for this report file on the red Emergency disk; besides, 
this disk should always be kept locked, or write-protected, to pre
vent accidents. Click on Done to return to the main Norton Utili
ties window. 

When you are ready to leave the Norton Disk Doctor, click on 
Quit from the File menu. Then, because there is no Finder on the 
red Emergency disk, click on Restart or ShutDown in the dialog 
box and try once again to boot from your hard disk. 

Next, the red Emergency disk is ejected. Ideally, your hard disk 
begins to start up and you see the Happy Mac icon on your screen. 

If you are still having problems, try running the Norton Disk Doc
tor a second time. It is entirely possible that one of the problems 
fixed during the first pass was disguising another error that is now 
preventing a successful startup. Running the Norton Disk Doctor 
for a second time will find and fix this problem. 

WORKING WITH DAMAGED FLOPPY DISKS 
Assuming that you used the Norton Installer to load the Norton 
Utilities onto your hard disk, the whole help system is available 
to you before you actually start the Norton Disk Doctor. How
ever, once you have launched the program, help is, once again, 
unavailable. 
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If you are working with a floppy disk, insert it into a floppy disk 
drive. Click on the Drive button (or use Command-D) until you 
see the disk you want to work with displayed in the dialog box. 
Click on Open, and when the main Norton Disk Doctor window 
appears, click on the Start button. 

If the Norton Disk Doctor finds problems on the disk, you have 
the option of ignoring or fixing the problem; take this opportunity 
to fix any problems as soon as they are found. 

If the Norton Disk Doctor cannot find your disk when you click 
on Open in the Choose volume to diagnose box, you may see the 
message 

Scanning SCSI bus ... 

as the program searches your system for more disk drives. If the 
program cannot find your hard disk, you probably have a hard
ware problem and should contact your dealer 's service depart
ment. If the disk is a floppy disk, and the Macintosh cannot 
recognize it, you will have to use a paperclip to eject the disk. Al
ternatively, switch your Macintosh off and on again; the disk will 
be ejected as your Macintosh restarts. 

SCSI BUS PROBLEMS 
The Macintosh uses the Small Computer System Interface (SCSI) 
bus to connect high-speed peripheral devices like external disk 
drives. Sometimes bad connections on this bus can cause prob
lems with these disk drives. You should not plug or unplug periph
erals into SCSI ports while your Mac is running-shut down your 
Mac and tum off the power first. Also, most SCSI peripherals 
have two connectors so that they can be daisy-chained together. 
Plug the first connector into your Macintosh and the other connec
tor into the next SCSI peripheral in the daisy chain. Up to seven 
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devices can be daisy-chained together at the same time, each with 
its own unique address. The last device in the chain must be prop
erly terminated so that the connectors are not left open. Some 
newer devices are self-terminating, but others require a SCSI ter
minator be plugged into the connector. 

Each device on the bus must have its own unique identification 
number. This is usually a switch on the back of the case; if two 
devices are set to the same number, your Mac will not be able to 
tell them apart, and this will disrupt the entire bus. 

NORTON DISK DOCTOR AND MULTIFINDER 
The Norton Disk Doctor will run under MultiFinder, but if you 
have a very large hard disk containing hundreds or possibly thou
sands of files, the Norton Disk Doctor may need more memory to 
run than is n01mally allocated to it by default. 

Click on the Norton Uti lities icon in the Finder, choose Get Info 
(Command-f) from the File menu, and then increase the Applica
tion Memory Size in the box at the bottom of the window. 

To make more memory avai lable, use the Finder rather than the 
MultiFinder. 

Choose Set Startup from the Special menu, and select the Finder 
radio button. Now choose Restart in the same menu to reinitialize 
your Mac and make it load the Finder rather than the MultiFinder. 

You can free up even more memory if you run the Norton Utilities 
in monochrome rather than in color. 

If you are attempting to diagnose your startup disk, you cannot 
use MultiFinder; you will have to run the Norton Disk Doctor 
from the red Emergency disk in order to repair the disk. 
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One of the most appalling prospects for a hard disk user is the 
idea of accidentally reformatting, or initializing, a hard disk-an 
operation that apparently destroys all the files and folders on the 
disk. With the Norton Utilities Format Recover, you can now res
cue data from a reformatted hard disk. 

The Macintosh itself has several built-in safeguards against acci
dentally reformatting your startup disk. If you use Erase Disk 
from the Special menu, you will see a dialog box containing the 
message 

That is the startup disk; it can't be erased. 

Still, accidents will happen, and this is where Format Recover 
comes into its own. 



HIGH· AND LOW-LEVEL DISK FORMATTING 
Before you can use a disk, it must frrst be physically (or low
level) formatted, and then it must be logically (or high-level) 
formatted. 

Physical formatting can take a long time to complete, whereas 
logical formatting is usually a relatively quick process. Unfortu
nately, hard disks and floppy disks are treated differently: 

• With hard disks, the physical format is usually done once, 
at the factory, and is never done again. The logical format 
is done next, and this logical formatting is what allows us 
to use the disk for storing files and folders. 

• In the case of floppy disks, the physical and logical format
ting are done at the same time, when you use the Erase 
Disk command from the Special menu. 

What can be confusing about all this is that the Erase Disk com
mand in the Special menu performs both physical and logical for
matting when you work with floppy disks, but it only does logical 
formatting when you work with hard disks. 

Physical formatting overwrites and destroys all of the original data 
on the disk; logical formatting does not-it merely resets the 
bookkeeping information on the disk. 

The original data is still on the disk, but there is no way of gaining 
access to it. This explains why Format Recover can rescue infor
mation from a reformatted hard disk but not from a reformatted 
floppy disk or from a hard disk that has been physically, or low
level, formatted. 

·j 
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LAUNCHING FORMAT RECOVER 
If your hard disk has been accidentally reformatted, you must start 
Format Recover from the red Emergency Disk, or better still , from 
your backup copy of the emergency disk. You must run Format 
Recover from the floppy disk because you cannot access your 
hard disk copy of Format Recover. 

Do this immediately, before loading anything to the hard disk. If 
you try to load programs first, you may overwrite the vital File
Saver information, in which case a complete recovery will be im
possible. Format Recover is automatic and easy to use. 

Recovering a 
Hard Disk Using FileSaver Information 
When you start up from the red Emergency disk, the Norton Utili
ties are loaded, and you will see the Norton Utilities selection 
screen. 

Click on Format Recover. A dialog box opens asking you to 
choose one of the four Format Recovery operations. Click on the 
first radio button, Restore Formatted or Crashed Disk. The other 
selections in this dialog box are described later in this Step. 

Next, choose the drive or volume you want to restore by clicking 
on the Drive button to cycle through all the disks attached to your 
Macintosh and then clicking on Open when your hard disk icon is 
displayed. 

Format Recover first looks for FileSaver information on the 
hard disk in an attempt to rescue your disk quickly. If FileSaver 
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information is present, Format Recover can use it, and you will 
see the dialog box shown in Figure 12.1. 

Format Recover shows you when the FileSaver information was 
last updated, and asks 

Do you want to completely restore the disk 
using this information? 

Your choices are as follows: 

• Restore. Make this selection if you want to restore your 
hard disk using the FileSaver information. 

• Keep Looking. Select this option to make Format Recover 
search your disk for more FileSaver information. A prog
ress bar shows you the state of the search; click on Cancel 
to abort the search. 
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• Figure 12.1: Format Recover uses FileSaver information to rescue your 
hard disk 
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• Reconstruct. If you choose this option, Format Recover 
will try to recover as much of your disk as it can and will 
not use the FileSaver information. This process is equiva
lent to using the Norton Utilities UnErase program to 
rescue files and folders. In fact, the menus and dialog 
boxes will say UnErase instead of Recover. 

• Cancel. Click on Cancel if you have changed your mind 
about recovering your disk. You return to the main Norton 
Utilities selection window. 

Select Restore, and Format Recover will use the FileSaver infor
mation to rescue the files and folders on your hard disk. When the 
process is complete, you will see a dialog box containing the 
message 

Successfully recovered the volume named 
"Hard Disk"! 

where "Hard Disk" is replaced by the name of your volume. 

Recovering a 
Hard Disk Without FileSaver Information 
If Format Recover was unable to find FileSaver information on 
your disk, you will see a window like that shown in Figure I 2.2. 

The window explains that Format Recover was unable to find 
FileSaver information. You may not have installed FileSaver yet, 
or if you did install it, the FileSaver information may be corrupted 
and unre liable. You have the following choices: 

• Search Disk. Choose this option if you think that FileS aver 
information should be on the disk. Format Recover will try 
to find the information a second time. 
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• Reconstruct. If Format Recover is unable to find FileS aver 
information, your best alternative is to click on Reconstruct 
and perform an UnErase on the files and folders on your 
disk. 

• Cancel. Select Cancel to return to the main Norton Utilities 
selection window without recovering anything. 

Click on Reconstruct, and Format Recover will do the best job it 
can of recovering your files. How to use UnErase is covered in 
Steps 13, 14, and 15 and wi ll not be described in detail here. 
However, you can select individual files or folders by clicking the 
mouse or groups of files by dragging the mouse, or you can use 
Select All from the Edit menu to recover all the files on your 
disk. Click on UnErase to start the rescue process. If you use this 
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• Figure 12.2: Format Recover gives you different choices if FileSaver 
information Is not present 
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technique, some files may not keep their original names, and you 
may have to work with them to restore their names. 

Installing Disk Protection 
The second option in the Format Recover opening window lets 
you create a new FileSaver file for a disk. Select the Install Disk 
Protection radio button, and click on OK. You will see the current 
Fi leSaver settings shown in the next window. If you want to 
change to another disk, click on Drive. There are three check
boxes in the lower part of this window. These checkboxes are very 
similar to the FileSaver control panel settings: 

• Volume Protection. Check this box to create a file contain
ing details of your disks. Format Recover will use this in
formation if you ever attempt a recovery operation after an 
accidental format of your hard disk. To keep the informa
tion in the recovery file as up-to-date as possible, you 
should install and use FileSaver as I described earlier in 
Step 4. 

• File Protection. Use this selection to save information on 
files as you delete them. UnErase can use this information 
when rescuing deleted files. You can also select how many 
deleted files you want to keep track of at a time. The de
fault number is 500 files . Keeping track of this number of 
files will occupy approximately 50K of disk space-about 
100 bytes are needed to keep track of each file. 

• SaveComments. Tum this option on, and the Finder's Get 
Info comments are saved and not lost each time you rebuild 
the desktop. 

Click on OK when you have made your selections, and you return 
to the Norton Utilities main selection window. 
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Manually Updating 
the Disk Protection Information 
You can update the FileSaver file manually if you click on the 
Update Disk Information radio button. Click on OK, and you will 
see the message 

1 FileSaver info file was found and was 
updated successfully. 

Click on OK to return to the Norton Utilities main selection 
window. 

Restoring the Finder's Comments 
Finally, if you select the Restore Finder Comments radio button, 
you can ensure that the Finder's Get Info comments will be re
stored after a desktop rebuild and will not be lost. After you select 
the drive you want to work with, a horizontal progress bar indi
cates the search for comments, and you are returned to the main 
Norton Utilities selection window. 

Choose Quit (Command-Q) to leave the utilities and return to the 
Finder. 
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Deleting files is easy, often much too easy. On the Macintosh, you 
delete a file by dragging it to the trashcan icon in the lower right
hand comer of the desktop. 

As long as you don't empty the trash, and the trashcan icon is still 
bulging, the fi le is still there and can be retrieved very quickly. 
The trashcan is a folder just like the other folders on your desktop. 
Double-click on the trashcan icon to open it just as you would any 
other folder. Now you can drag the fi le back into the folder of 
your choice. However, if the trashcan is not bulging or you used 
Empty Trash from the Special menu, the file has been deleted. 

HOW FILES ARE DELETED 
There are several ways of deleting files on the Macintosh. Empty
ing the trashcan is one way, but the Mac doesn't always wait for 
you to do it. Sometimes, if the Mac needs the space occupied by 
the trashed file, the Mac may delete the fi le automatically. 



Similarly, the contents of the trashcan are dumped when you 
launch a new application or shut down your Macintosh. Some ap
plications give you the option of deleting files directly without 
putting them in the trash first. When this option is available in a 
program, it is often found in the File menu, and it doesn't usually 
give you a second chance. As soon as you click on the OK button 
the ftle is deleted-or is it? 

WHAT HAPPENS 
WHEN YOU DELETE A FILE? 
Before describing how UnErase does its job, I want to explain ex
actly what happens when you do delete a file using one of the 
mechanisms described above. When you delete the file or empty 
the trash, the actual data is not removed from the disk; it is still 
there in its original location. Only the information needed to lo
cate the file and display its icon are actually removed from the 
disk. In technical terms, the file manager examines the catalog 
tree to find where the file was stored and marks these blocks as 
available blocks in the volume bit map. Then the record for the 
file is removed from the catalog tree. This explains why you can
not display the file on the desktop or see its icon in the Finder. No 
data is actually changed until the Mac is told to write another file 
over the same disk space. As long as the information in the ftle is 
not overwritten, it can be recovered quite easily. 

WHAT HAPPENS 
WHEN YOU ADD A NEW FILE? 
When you add a new file to your disk, the Macintosh looks for the 
next available area of free space on your disk. If the file is small 
enough to fit into this area of free space, the Mac simply slots 
it in. 
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However, if the file is too large, the Mac splits it up into several 
pieces, recording it into areas on the disk that are not numbered 
consecutively. In other words, the file becomes fragmented. 

Saving the new file on the disk destroys a deleted file's data. If the 
new file is larger than the old one, the old file is completely oblit
erated. If the new file is smaJier than the old one, some unknown 
amount of the old file will remain on the disk until it is finally 
overwritten by some future write- to-disk operation. 

The longer you wait, and the more you use your disk before at
tempting a recovery operation, the slimmer your chances become 
of making a complete recovery. 

The most important point to remember about file recovery is you 
must not save anything on the disk until you have completed the 
recovery operation. 

Do not even instaJI the Norton Utilities on your hard disk; instead, 
you should launch UnErase from the red Emergency disk. Install 
the complete package of utili ties on your hard disk only when the 
recovery process is completely finished. By following this rule, 
you will not overwrite the erased file 's data, and you will increase 
the chances of a complete recovery. 

USING UNERASE 
TO RECOVER DELETED FILES 
If the deleted file is a short file, there is an excellent chance that 
UnErase will be able to restore it on the first attempt. However, if 
the file is badly fragmented or part of it has been overwritten by 
another file, the chances of a full recovery are substantially Jess, 
and a completely overwritten file cannot be recovered by any util
ity program. 

Quick 



If you want to recover a deleted file and you have not yet installed 
the Norton Utilities onto your hard disk, you should shut down 
your Mac and restart using the red Emergency disk. 

If you installed the utilities before deleting the file, or you want to 
recover a file accidentally deleted from a floppy disk, double-click 
on the Norton Utilities icon to start the program. 

In either case, when the main Norton Utilities window opens, 
choose UnErase, and you will see the window shown in Fig
ure 13.1. 

First, choose the disk or volume that contains the deleted files that 
you want to recover. Click on the disk icon or the Drive button, or 
type Command-D to cycle through all the drives connected to 
your Mac. 
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• Figure 13.1: Choose the disk or volume that you want to unerase 
files from 

& Running with Norton Utilities on the Macintosh 



If you are using FileSaver, a message box opens telling you that 
UnErase is looking for FileSaver information to help with the re
covery process. (Fi le recovery without using FileSaver informa
tion is described in later Steps.) 

When you have selected the correct drive, note that there are three 
recovery-option radio buttons shown in the lower half of this 
window. 

If you are using FileSaver (described in Step 4), select the Quick 
UnErase radio button, and click on OK to continue. 

The other two radio buttons shown in this window, Scan for Spe
cific Fi le types and Text Search, are described in Steps 14 and 15 
respectively. 

THE UNERASE WINDOW 
Now you will see the main UnErase window as Figure 13.2 
shows. 

UnErase collects a list of all the fi les it can find using the File
Saver information that could be candidates for unerasure and 
displays them in the main part of the UnErase window. This scrol
lable li st includes the file or files that you are looking for, but it 
also includes a lot of other files, many of which you will not be 
interested in at all. Programs such as Microsoft's Excel create 
many temporary fi les as part of their normal operation, but you 
would not want to recover any of these files. Information on each 
file is listed in seven columns from left to right across the window. 

• Name. Name of the file. 

• Data. Size in K of the file's data fork. 

• Rsrc. Size inK of the file's resource fork. 
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• Figure 13.2: The main UnErase window 

• Modified Date. Date and time the file was last changed. 

• Type. File type. 

• Creator. The four-letter code that identifies the creator of 
the file. 

• Recoverability. This is the prognosis for the recovery, 
ranging from Poor, to Fair, Good, Very Good, and Excel
lent in increasing order of the likelihood of a successful 
recovery. A rating of Excellent usually means that no part 
of the file has been overwritten, and the file can usually be 
completely recovered. This column will display informa
tion other than the recovery prognosis later in the unerase 
process. 

All this information helps you to track down the file you want to 
unerase. If the list is too long to fit into the window, click on the 
scroll bars to move through the list. 
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Also, you can click on the Sort icon at the top right of the window 
to rearrange the files listed in the main UnErase window. You can 
choose to sort your files by one of the following criteria: 

• by Name 

• by Date 

• by Size 

• by Kind 

• by Type 

• by Creator 

To see more information about a specific file, click on the ftle to 
highlight it and then click on the Get Info icon at the top right of 
the main window, or choose Get Info (Command-I) from the Op
tions menu. A dialog box opens as shown in Figure 13.3. 
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The top half of the dialog box contains information similar to that 
found on the main UnErase window, including the file name, the 
file type, the name of the application program that created the file, 
and the create date. 

In the lower half of the window, you will see the name of the pro
gram that deleted the file, the time and date when it was deleted, 
the name of the parent folder, details of how the file is divided be
tween the data fork and the resource fork, and final ly, the amount 
of the file that is recoverable. This last entry also details the num
ber of sectors originally occupied by the file that are now in use 
by another file. Click on OK or Cancel when you have seen 
enough. 

Sometimes you need to examine the actual contents of a file to de
termine that it really is the file you are looking for. Click on View 
File, or choose View File (Command-O) from the Options menu 
to look at the file contents. 

The success of viewing a file depends on the file type. If the file is 
a text file, you will probably be able to make sense of the file con
tents, but if the file is any other kind of file, it will just look like 
random characters on the screen. 

Click on the radio buttons at the bottom of the View File window 
to choose between displays of the data fork, the resource fork, or 
the resource map for the file. If the file is too big to fit in memory, 
UnErase wi ll tell you and ask if you want to load just the first 
150K of the file. Click on Done to return to the main UnErase 
window. 

UNERASING FILES 
Now that you have located the file or files that you want to re
cover, choose the disk where you want to write the files after you 
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have recovered them. Most of the time you will want to store 
them on a different disk from the original disk, especially if the 
original disk is badly damaged. 

If you are recovering files from a floppy disk, store the recovered 
versions on your hard disk, and if you are recovering files from 
your hard disk, store them on a floppy disk. By doing this, you 
prevent the first file recovered from overwriting other areas of the 
disk that may be needed to recover other files later on. 

Click on the disk icon in the top center of the window to cycle 
through all the disk drives connected to your Macintosh, or choose 
Change Destination Volume from the Options menu and select a 
destination disk to receive the unerased files (see Figure I 3.2). 

When you have selected the first file you want to recover and the 
disk you want to write the recovered file to, click on the UnErase 
button at the top left of the window, or type Command-S. The 
graphic in this part of the window shows the recovery process 
flowing from the trashcan on the left, through the UnErase icon, 
to the destination disk that you have chosen to receive the 
unerased files. 

If you try to recover a file to its own disk, a window containing a 
warning message opens. This message reminds you that if you 
proceed, you might inadvertently overwrite the area of the disk in 
use by another fi le, thus preventing you from making a complete 
recovery of this file later. Click on Cancel to return to the main 
UnErase window without recovering the file so that you can select 
a different destination disk, or choose Continue to recover the file 
to its own disk. 

When the file has been successfully unerased, the text under the 
Recoverability column changes to Recovered. Choose the next file 
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for recovery and click on the UnErase icon once again, repeating 
this process until all your files have been recovered. 

The files rescued by UnErase are placed inside a folder called Re
covered Files in the root directory of the destination disk. Each 
UnErase session makes its own folder inside Recovered Files, 
usually caJied by the same name as the original disk that contained 
the deleted files. For example, if you deleted a file from a floppy 
disk called Examples, you will find a folder called Examples in
side the Recovered Files folder. 

If you want to store the recovered files somewhere else, use 
Change Destination Folder from the Options menu to choose an
other folder on the destination disk. 

When you have completed all your file recovery operations, click 
on Quit from the File menu to leave UnErase and return to the 
Finder. 

FILE RECOVERY 
WITHOUT FILESAVER PROTECTION 
File recovery is almost a certain thing when FileSaver information 
is available, but if you are not using FileSaver protection, see 
Step 4 for a description of how to configure it using the control 
panel. 

If FileSaver information is not available for your disk, you will 
see this message box open when you choose the drive in UnErase. 

FileSaver protection was not enabled for 

this 'disk, so only a few files were found 

to Quick-UnErase. Try the other two UnErase 
methods for better results. 
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Because the methods used by UnErase are completely non
destructive (as long as you use a different destination disk) unlike 
methods used by other utilities or on other computer systems, you 
can try to recover a file using each of the methods available in 
UnErase and compare the results. 

Recovering files in groups is covered in the next step, Step 14, 
and identifying files for recovery by using a text search is de
scribed in Step 15. 
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If you have erased files from a disk that did not have FileSaver 
protection enabled, UnErase may not be able to find all of your 
deleted ftles when you use the Quick UnErase option. However, 
there is still a very good possibility that your files can be recov
ered if you use the second option in UnErase, Scan for specific 
File Types. 

If you want to recover a deleted file and you have not yet installed 
the Norton Utilities onto your hard disk, remember to shut down 
your Macintosh and restart using the red Emergency disk. This 
way you wi ll not accidentally install the Norton Utilities on top of 
the file you are trying to recover. You should install the Norton 
Utilities onto your hard disk after the recovery operation is 
complete. 

If you installed the utilities before you erased the document you 
want to recover, you can run the Norton Utilities from your hard 
disk as normal. 



SCANNING FOR SPECIFIC FILE TYPES 
In either case, when the main Norton Utilities window opens, 
click on UnErase, and select the disk you want to work with by 
clicking on the drive icon or the Drive button, or by typing Com
mand-D. Now select the Scan for specific File Types radio button, 
and then click on OK. 

Next, the window shown in Figure 14.1 opens. This window lists 
all the different applications that you can have UnErase search 
for; all you need to know in order to recover a file is the name 
of the application program you used to create the document in the 
first place. 
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• Figure 14.1: The UnErase window a/fows you to specify file types 
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UnErase can recover files made by the following applications: 

Acta 2.0 MacDraft Pier MORE3.0 

Acta 3.0 Mac Draw MORE II 

Business Filevision MacPaint 1.0 Omnis 3 

Cricket Presents MacPaint 2.0 Packlt archive 

CricketDraw MacProject II PageMaker 2.0 

Dollars and MacSqz! PageMaker 3.0 
$ense 4.0 Mac Write PowerPoint 
FileMaker Macwrite 5.0 QuickMail address 
Filevision IV 

Microsoft Excel book, form, and 

Freehand file and chart 
group 

Full Impact Microsoft Word 3.0 Stufflt archive 

Full Write Microsoft Word 4.0 SuperPaint 

Professional 
Microsoft Works WingZ 

MacCalc data 2.0DB, WP, Write Now 1.0 

MacDraft and SS Write Now 2.0 
MORE 1.0 

UnErase can also recover categories of files or documents such as 
Any plain-text file, a TIFF file, or even the Norton FileSaver data 
file. These categories of files are listed below: 

All Resource files 

Any plain-text file 

GIF picture file 

Hypercard stack 

MacServe volume 
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Norton FileSaver data file 

PICT2 file 

PostScript file 

TIFF file 

To highlight your selection in this list, click on the application 
name or document category name you need. You can choose sev
eral options in the list if you wish to recover several different 
kinds of files at the same time. Hold down the Shift key as you 
click on additional fi le types. If you don't remember the name of 
the application program you used to create the file, click on the 
Select AJI button or use Select All from the Edit menu (Com
mand-A) to choose all the options in this list. If you click on Se
lect All, the whole list will be highlighted, and UnErase will 
search for files made by aJl of these applications. 

CONFIGURING THE SEARCH OPTIONS 
Next, click on the Options button, and you will see the window 
shown in Figure 14.2. 

There are three radio buttons on this window. They allow you to 
specify the range of the search. 

• Search erased data space only 

• Search occupied file space only 

• Search Entire Disk 

CONFIGURING THE ADVANCED OPTIONS 
Click on the Advanced Option checkbox to open the lower half of 
the Options window where you will see more checkboxes for ad
ditional UnErase search criteria, as Figure 14.3 shows. 
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• Figure 14.2: The Options window allows you to define the area of the 
disk to search 
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The lower half of the Options dialog box contains these two 
checkboxes: 

• Recover unknown file fragments. If you check this option, 
UnErase converts any unk.'llown file types or file fragments 
that it finds into text files. Then you can use TeachText or 
your favorite word processor to look at the fragments and 
decide if they are worth keeping. 

• Exhaustive search through sectors. Check this box to make 
UnErase perform an extensive search through all parts of 
each sector on your disk. However, this search may try to 
pick up some nonexistent file types. 

Finally, there are two data entry boxes at the bottom of this dialog 
box where you can set two more UnErase parameters: 

• File Size Limit. Here you can enter a file size limit for the 
search, expressed as a maximum number of sectors, where 
a sector is 512 bytes. If you know that you do not have any 
files bigger than a certain size, you can make UnErase limit 
the scope of its search. 

• Sectors per allocation block. If your disk is very badly 
damaged, it may have lost some of its bookkeeping infor
mation, including the number of disk sectors that make up 
an allocation block. Most hard disks smaller than 20MB 
have one sector per allocation block, hard disks in the 
20MB to 60MB range have two sectors per allocation 
block, and disks that are larger than 60MB have three 
sectors per allocation block. Enter the number of sectors 
per allocation unit for your disk into this box. 

Click on OK when you have completed your selections to return 
to the application selection dialog box. Then you can click on the 
Do It button to start the search process running. 
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A window opens containing a progress bar that shows you how far 
along UnErase is in the search process. When the search for the 
file types you requested is complete, the documents available for 
recovery are listed in the main UnErase window, but their names 
are given in terms of the original application you selected for re
covery. For example, if you started out to recover a TeachText file 
and you selected Any plain-text fi le in the application selection 
window, you will see the file listed as 

?Any plain-text file 00 

A second text file would be called ?Any plain-text file 01, the 
third Any plain-text file 02, and so on. The Data and Resource 
size, Modified Date, Type, Creator, and Recoverability columns 
all contain information appropriate to the documents that UnErase 
found. 

Move the highlight onto the file or document you want to recover, 
and then click on UnErase or select UnErase from the UnErase 
menu (Command-S). You can also select more than one file by us
ing Shift-click. When UnErase has completed its work, the word 
Recovered appears in the recoverabil ity column. 

The documents are not unerased to their original location on the 
disk but are recovered into a folder named after the application 
you originally selected. For example, if you are recovering Teach
Text text files, the fil es will be recovered into a new folder called 
Any plain-text files inside the Recovered Files folder located in 
the root directory of your hard disk. You can rename these files 
and relocate them on your hard disk as you wish. 

If you want to store the recovered files somewhere else, use 
Change Destination Volume to specify another disk or use Change 
Destination Folder to put them in a different folder. Both of these 
selections can be found in the Options menu. 
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If UnErase does not find any files corresponding to the application 
you selected, you will see a message box open containing themes
sage "No files were found to UnErase." Click on OK to dismiss 
the message box. 

If you are certain that there are still erased files on the disk in 
question and you cannot recover them using Scan for specific File 
Types, try using UnErase's text search option, described in the 
next Step. 

Select Quit from the File menu to close UnErase and return to the 
Finder. Remember that there is no Finder on the red Emergency 
disk, so you should choose Restart or Shut Down. 
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If both Quick UnErase and Scan for Specific File Types have 
failed to recover your lost documents, things do not look good. 
However, there is one more option in UnErase that you can use as 
a last resort Text Search. You can use Text Search to browse 
through your disk looking for text that matches a specific text 
string, and once you have found it, attempt to recover that part of 
the document or file. 

Often, recovering documents or files is not as straightforward as it 
seemed in Steps 13 and 14. All or part of the file may have been 
overwritten by another before you realize that you want to recover 
the erased file. Several factors determine whether recovery is 
possible, including the length of the new and erased files and 
the existence or nonexistence of the erased file's bookkeeping 
information. 

The single most important aspect of this kind of recovery opera
tion is how much you know about the original contents of the file. 



If you know nothing about the file, it may be impossible to deter
mine when you have recovered it completely. 

If the file is an application program file, running only the re
covered portion can lead to unpredictable-and unpleasant-results. 
The only safe way to proceed in this case is to delete the partial 
file and reload the entire file from the original disks or your 
backup set. 

If you can remember a word or a phrase that the file contained be
fore it was deleted, you can search for that word or phrase using 
Text Search. 

To start UnErasing with Text Search, launch the Norton Utilities 
as described in previous Steps: either from the red Emergency 
disk if you have not yet installed the utilities, or directly from 
your hard disk if the utilities were installed before you deleted the 
file you are now trying to recover. 

When you see the main Norton Utilities window, click on UnErase, 
and then select the disk drive or volume that you want to unerase 
from. Click on the disk icon or on the Drive button, or type Com
mand-O to change to the next drive mounted on your Macintosh. 

When you have chosen the disk drive to unerase from, next select 
the Text Search radio button, and then click on OK to dismiss this 
dialog box. 

ENTERING THE SEARCH TEXT 
The Text to Search For dialog box opens next, as Figure 15.1 
shows. 
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• Figure 15.1: In this dialog box, enter the word or phrase you want to 
search for 

Type in the word or words you want UnErase to look for into the 
upper box labeled ASCII. As you type in the characters, you will 
see their hexadecimal equivalents appear in the lower box labeled 
Hex. Alternatively, if you are a programmer and you think in hex, 
click on the Hex box to enter the text directly into this box in hex. 
UnErase translates the characters into ASCII and displays them in 
the ASCII box above. 

If you are not sure if the words you are looking for in the file are 
in upper- or lowercase, make sure that the Ignore Case checkbox 
is checked, and UnErase will look for both. 

In other words, norton, Norton, and NORTON will all be treated 
the same if the Ignore Case box is c hecked. If you want to be very 
precise in the search, remove the check mark to make the search 
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become case specific, where Norton and NORTON are not the 
same. Click on Find to start the search. 

As UnErase looks for the search text, a horizontal graph shows 
progress, and a count of all the matches found is shown under this 
bar. (UnErase searches only the erased portion of the disk.) 

When the search is complete, the file fragments containing the 
search text are listed in the main UnErase window. These file frag
ments are titled ?TextSearch followed by the fust 16 characters of 
the text you were looking for contained inside quotation marks. 
For example, if the search text was Norton, the first file in the list 
will be called ?TextSearch"Norton" 00. Click on View File, or use 
View File (Command-O) from the Options menu to look at the 
contents of the file before you go on to complete the recovery 
process. This way you can make sure that you are recovering the 
right thing. Remember that View File can only show you the frrst 
ISOK of a file, and it cannot display graphics files. 

USING THE UNERASE MENU 
There are several selections in the UnErase menu that you can use 
to reconstruct or rebuild files, piece by piece. If the original file 
has been partially overwritten, you might still be able to recover 
some portion of the fi le and save yourself some time; however, 
this usually only applies to text files. 

Since program files are so complex, and program code must be 
absolutely correct in order to function properly, a partial recovery 
of a program is more of a hindrance than a help. 

Before using the UnErase menu, place the highlight over the file 
you want to work with, and then choose the selection from the 
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menu. The first three selections in the UnErase menu apply to 
complete ftles or documents; the last three selections apply only 
to the text portion of a file. The menu contains the following 
selections: 

• UnErase is the same as the UnErase button in the 
main UnErase window. 

• Save As allows you to select the file name you want to use 
when the ftle is recovered. If you are using Directory Assis
tance, a dialog box opens that gives you all the power of 
Directory Assistance in creating new folders, changing to 
another disk, and so on. 

• Append To lets you add the contents of the file you are 
about to recover to the end of another file. You can use this 
option to add recovered word processor text to the end of 
an already existing word processor file. 

• Save Text Only strips the text component out of a file and 
recovers that text portion, discarding the rest. You might try 
this as a last resort, especially if your recovery attempts on 
a file are going badly. You may lose the formatting infor
mation held in a word processor file, but you may be able 
to recover some usable text, and this method is a lot faster 
than retyping the entire document over again. 

• Save Text As allows you to specify a new name that will be 
used to save the text. Again, a Directory Assistance dialog 
box opens so you can specify folder and document name, 
as needed. 

• Append Text To allows you to join the text you have recov
ered to the end of an exjsting document. In this way, you 
can accumulate several text fragments and join them to
gether into one file. You can use your word processor to 
rearrange the order of the fragments inside the file if neces
sary, once the recovery is complete. 
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Using these selections, you can recover pieces of an erased file, 
join the fragments together as you go, and reconstruct the file by 
hand. This can be a long and tedious process, but the tools pro
vided here by the Norton Utilities go a long way towards making 
the process as straightforward and simple as it can be. 

Be careful if you are unerasing to floppy disk, as UnErase does 
not tell you the amount of free space available on the destination 
disk; you can occasionally select more files for recovery than will 
fit onto a floppy disk. 

MULTIPLE UNERASE SESSIONS 
There are two powerful selections in the File menu that you can 
use during a recovery operation: Start Over and Close. 

• Start Over (Command-N) allows you to open several 
UnErase sessions, one on top of the other, and you can 
even use a different recovery technique in each session. 
Because UnErase does not recover files back to their origi
nal location, nothing on the original disk is ever changed. 
You can try several different rescue methods on the same 
file or group of files and keep the results that you think 
represent the best of all the methods. 

• Close (Command-W) closes the currently active UnErase 
session and activates the previous session. 

Use the selections in the Utilities menu to change to one of the 
other Norton Utilities. When you have finished using UnErase, 
choose Quit (Command-Q) from the File menu to return to the 
Finder if you launched the utilities from your hard disk. Remem
ber that the red Emergency disk does not contain a Finder, and 
you will have to choose Restart or ShutDown instead. 
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A FINAL NOTE ON FILE RECOVERY 
As you now know, file recovery is by no means certain. Many 
aspects of the recovery process influence the success of any re
covery attempt. The file recovery process can be difficult; indeed, 
recovery of program files can prove quite impossible under cir
cumstances where part of the fi le has been overwritten. However, 
the chances are that the file can't be recovered by anyone if you 
can't rescue it using the Norton Utilities. 
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Unfragmenting 
Your Hard Disk 

Speed Disk is one of the most important and often-used of all the 
Norton Utilities. Before describing how to use Speed Disk, you 
need to understand a little about how disks work in the Macintosh 
and how your files may become fragmented over time. 

The smallest number of bytes that can be read or written to a disk 
is a single sector of 512 bytes. Files are written to the hard disk in 
groups of sectors. When you write a file to the disk, it occupies 
the first set of sectors available. The second file you write occu
pies the next group of available sectors. Then, if you modify the 
first file by increasing its size, the Mac cannot push the second 
file farther down the disk to make space for the larger first file. In
stead, the Mac fragments this file by splitting it into two pieces. 
As you add, modify, and remove files in your day-to-day work, 
your hard disk slowly becomes more and more fragmented. The 
Mac was designed to work this way, and most of the time, the sys
tem works well. 



The potential problem with fragmentation is that the disk heads 
have to move to different locations on the disk to read or write to 
a fragmented file. This takes more time than reading the same file 
as a series of consecutive sectors. By reducing or eliminating frag
mentation, you can restore the original level of performance of 
your disk. 

Another benefit of unfragmenting a disk is that the Mac is less 
likely to fragment files that you subsequently add to your disk. If 
you should delete and then try to unerase any of these added 
files, your chances of success would be higher because un
fragmented files are usually easier to unerase. On the other hand, 
unfragmenting, or optimizing, your disk will probably make it 
impossible to recover any files that were deleted before the opti
mization. The reason for this is that Speed Disk moves data by 
rewriting it to new locations, and it will probably write over any 
erased fi les in the process. 

To remove the effects of file fragmentation, all the files on your 
disk must be rearranged so that they consist of consecutive sec
tors. You can do this yourself by copying all the files and folders 
to backup disks, reformatting or reinitializing the hard disk, and 
reloading all the files back onto the hard disk; but that would be a 
tremendous amount of tedious work. It is much easier to use 
Speed Disk. 

PRECAUTIONS 
TO TAKE BEFORE USING SPEED DISK 
There are several precautions you must take before you run Speed 
Disk on your hard disk: 

• If there are files on your disk that you know you don't 
want, throw them into the Trash. Speed Disk can work 
more efficiently using the extra disk space. 
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• Completely back up your hard disk in case of incompatibil
ity between Speed Disk and some of your applications. 

• Make sure that you have the original distribution disks for 
any software that is copy-protected so that you can reinstall 
it if necessary. Some copy-protection schemes make use of 
hidden files that may be moved by Speed Disk. 

• Speed Disk will not allow you to optimize your startup 
drive. If you usually start your Mac from your hard disk, 
you should launch Speed Disk from your copy of the Nor
ton Applications disk instead. 

• Make sure there are no open or active files on the volume 
you want to optimize. 

• If you use MultiFinder and you have a large hard disk with 
more than 4,000 files, consider increasing Speed Disk's 
Application Memory size from the default 600K. Choose 
the Speed Disk icon, select the Get Info (Command-I) 
command from the File menu, and increase the value 
shown in the Application Memory Size box at the bottom 
of the window. Speed Disk will run faster with more mem
ory allocated. 

• If you use Virtual, be sure to tum off virtual memory before 
running Speed Disk. 

RUNNING SPEED DISK 
Remember to start Speed Disk from the Norton Applications disk 
if you want to unfragment files on your startup hard disk. You can 
look at the files on your startup disk with Speed Disk, but you 
cannot unfragment them. You can start Speed Disk by double
clicking on the Speed Disk icon in the Norton Utilities folder, or if 
you start the Norton Utilities, you can choose Speed Disk from the 
list in the Utilities menu . 
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There are two ways to use Speed Disk: you can use the default 
Easy mode, or you can select Go to Expert in the Options menu to 
use all of Speed Disk's advanced features. 

Using the Easy Level 
The Speed Disk window is shown in Figure 16.1. 

The top part of the window contains a map of the selected drive, 
showing the used and free areas of the disk. The black (or colored) 
areas represent files and folders, and the free areas are shown in 
white. The display is scaled according to the capacity of the disk 
selected: the smaller the disk, the greater the amount of magnifica
tion shown by this display. 
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• Figure 16.1: The Speed Disk window In the default Easy mode 
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Below this is the logo or display area. When you are optimizing a 
disk or checking a drive, this area shows the progress made as 
a bar graph; the rest of the time it displays the Speed Disk logo. 

There are two buttons in the next box: Check Drive and Optimize. 
Check Drive is used to read folder and file information from 
the hard disk, and Optimize actually starts the unfragmentation 
process going. Always use Check Drive if you are considering 
optimizing your disk; after all, optimization may not always be 
necessary. 

If you click on Optimize and the selected drive is your startup 
disk, or it is locked, or you have left files open, you will see a dia
log box telling you why the optimization process cannot continue. 

The last three boxes in this window are the diagnosis area. Here 
you will see information about the selected drive, including Speed 
Disk's assessment of the amount of fragmentation on the selected 
disk and the program's recommended course of action. 

Speed Disk uses seven levels of messages, ranging from "No 
Need To Optimize--this disk is in great shape!" to "This Disk Is 
Dangerously Fragmented." Each message indicates more frag
mentation than the last. These messages are displayed above the 
disk icon in the diagnosis area of the Speed Disk window. Speed 
Disk also gives you an indication of the performance increase you 
will see when the optimization is complete. 

Click on the arrows in the drive selection area below the disk icon 
or press the Tab key to change to another drive. Then click on 
Check Drive to evaluate the amount of fragmentation on this new 
disk, and you will see one of Speed Disk's seven messages sum
marizing the status of the files on the disk. 
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The last box in this part of the window shows the number of files 
on the selected disk, as well as the amount of space in use by 
files and the amount of free space. All these totals are given in 
megabytes. 

Select Show Pencil (Command-P) from the Options menu to see 
the animated pencil display during optimization; the pencil indi
cates reading and writing and works only in black and white dis
play mode. 

Click on Optimize when you are ready to start Speed Disk work
ing on your disk. A horizontal progress bar appears in the logo 
area measuring the optimization process from 0 to 100 percent. 
You will also see a message above the bar describing the current 
activity, such as "Optimizing applications." The main display area 
indicates the placement of files on the disk by moving the black 
blocks that represent your files. If you turned on the pencil, you 
will also see an animated display of disk reading and writing. 
When the optimization is complete, Speed Disk plays a chime to 
let you know it is done. This means you can leave your Mac run
ning, and as long as you stay within earshot, you will hear when 
the optimization is complete. 

To use Speed Disk's advanced features, cHck on Go To Expert 
(Command-E) in the Options menu. You will see several things 
change in the Speed Disk window. After you have chosen Go To 
Expert from this menu, that selection automatically changes to Go 
To Easy. You can also double-click in the left side of the Speed 
Disk logo to switch into Expert mode. 

Using the Expert Level 
Figure 16.2 shows the Speed Disk window in Expert mode. 
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• Figure 16.2: The Speed Disk window in Expert mode 

The main part of the Speed Disk window does not change in Ex
pert mode and shows the display of the occupied and free parts of 
the disk. However, the logo area in the lower left part of the Speed 
Disk window splits into two boxes. The left box shows a magnify
ing glass, and the right box shows a list of file types. If you move 
the cursor into the display area at the top of the window, it 
changes into a small magnifying glass, and an enlarged view of 
the file that the cursor is on appears in the large magnifying glass 
box at the bottom of the window. The number of the block at the 
center of the magnifying glass is shown above this display. If the 
magnifying glass goes outside the borders of the disk display, 
the blocks are dimmed. 

The file (or folder) name, icon, and type under the crosshairs of 
the magnifying glass are shown in the box next to the large mag
nifying glass, along with the number of fragments that the file is 
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divided into. The information changes as you move the magnify
ing glass from one file to the next. The small checkboxes and list 
of file types indicate the kind of file that the magnifying glass is 
currently examining. For example, if you move the magnifying 
glass onto the light-colored free or unoccupied area of the disk, 
the check mark moves to the Free box at the end of the list; if the 
magnifying glass stops over a document, you will see the familiar 
document icon, and the check mark moves to the Document box. 
In Figure 16.2, the Norton Utilities application is broken into two 
fragments. 

If you are using color on your Macintosh and you click on one of 
these small file-type checkboxes, you can select the color used to 
denote these different types of files. 

All the selections in the Options menu are toggles-they don't do 
anything when you initially select them, but they affect the way 
that the optimization is done when you start optimizing. A check 
mark to the left of the menu item indicates that the setting is 
toggled on; select the item a second time to toggle the selection 
off again. 

If you choose Prioritize Files from the Options menu, Speed Disk 
arranges your files into the following order: 

• Directory: directories or folders 

• System: system files 

• Init/cdev: startup documents and control panel devices 

• Font/DA: fonts and desk accessories 

• Application: application files 

• Document: document files 

• Desktop: desktop files 
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• Defective: defective files 

• Unknown: unknown file types 

• Free: free, unused disk space 

Prioritizing files ensures a completely optimized disk; however, 
the optimization may take a little longer to complete. 

If you do not use Prioritize Files from the Options menu, Speed 
Disk arranges your files into any convenient order. This is most 
obvious if you are using color, as Speed Disk uses different colors 
to differentiate between file types. 

If you select Verify Media from the Options menu, Speed Disk 
will isolate and mark any bad blocks it finds during the course of 
the optimization so that they will never be used in the future. 
Similarly, if you select Verify Data from the Options menu, Speed 
Disk will check that the data written to disk is accurate. 

Although choosing these two options will slow down the unfrag
mentation process somewhat, I recommend you select both of 
them to give yourself the greatest level of confidence in your data 
after the optimization. 

If you select Turbocharge (Command-T) from the Options menu, 
you can make the optimization run faster. Turbocharge turns off 
the on-screen animation and also forces Speed Disk to work in 
black and white, even if you are using color. You can also double
click on the file information box (the second box from the left) to 
switch in and out of turbo mode. 

Click on the Optimize button when you have made your choices 
in the Options menu and you are ready to start unfragmenting 
your files. 
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The Speed Disk window during optimization at the Expert level is 
the same as it was at the Easy level with two additional pieces of 
information. The elapsed time the optimization takes is shown be
low the horizontal progress bar, which replaces the large magnify
ing glass during optimization. Information about the actual file 
being optimized is displayed in the file information area (the sec
ond box from the left). 

Optimization can take a long time. especially if you are un
fragmenting a large disk containing hundreds of files. Monitor 
the progress bar to get an idea of how long the entire process 
will take. 

When you started the optimization. the Optimize button changed 
into the Stop button. You can click on Stop if you want to halt the 
unfragmentation process early, but you will probably have to wait 
for Speed Disk to reach a convenient point before it can stop. 

EXPLORING WITH SPEED DISK 
You can use three of the selections in the Explore menu without 
doing a complete disk optimization. The selections are Check 
Drive, Check Media, and Check Files. 

• Check Drive, (Command-D). is identical in function to 
the Check Drive icon at the bottom of the main Speed Disk 
window. Use it to read data from the selected disk and to 
calculate the percentage of file fragmentation and the size 
of the largest single area of free space on your disk. 

• Check Media, (Command-M), is similar in function to the 
Verify Media selection. You can run Check Media any time 
you like without doing a full optimization, whereas you can 
only run Verify Media as part of an optimization. 

• Check Files, (Command-F), confirms that the bookkeeping 
information contained on your disk actually matches the 

& Running with Norton Utilities on the Macintosh 



files and folders written there. If you find serious errors, 
consider using the Norton Disk Doctor to correct them 
before running the optimization. 

To get the most out of Speed Disk at the Expert level, you should 
either: 

• Run Check Media and Check Files from the Explore menu 
manually before you start the optimization, or 

• Toggle the setting for Verify Media in the Options menu to 
on. All files are verified automatically every time you run 
an optimization. 

You can use Largest Free Contiguous (Command-L) to find the 
size of the largest single area of free disk space on your disk. This 
can sometimes be important for applications using virtual mem
ory, as they need large areas of disk space to use as swap space. 

When you have finished using Speed Disk, select Quit (Com
mand-Q) from the File menu to return to the Norton Utilities 
startup screen or to return to the Norton Utilities folder. 

Unfragmenting Your Hard 



• 

• 

• • • • • • • • • • • 

Editing Your 
Disks 

The Disk Editor lets you examine and edit any part of a floppy or 
hard disk, sometimes even if the Macintosh refuses to recognize 
the disk. As you would expect, you can use the Disk Editor to 
look at folders and documents, but you can also look at informa
tion that is harder to get at, such as the catalog and extents trees 
where the Mac keeps bookkeeping information for all your files. 

The Disk Editor also lets you view disk information in its native 
(that is, correct) format. For example, the boot block information 
is in a format that is tailored to that specific data; the extents tree 
and the catalog tree use an entirely different format; and so on. 

The Disk Editor enables you to peer into the dark comers of your 
disks and review information that is not normally accessible with
out a great deal of complex programming. 

The Disk Editor is a very powerful tool for looking at the structure 
of your disk, but you can also use it to change the information on 
your disk. If you make a mistake in this kind of operation, you 



may change an application so that it will no longer run as you ex
pect it to. Be very careful when using the Disk Editor, and don't 
save anything back to the disk unless you are absolutely certain 
that you know what you are doing. 

If the Disk Editor surprises you by opening a dialog box asking if 
you want to write the changed sectors to the disk, just click on the 
Cancel button. 

VIEWING AND 
EDITING THE CONTENTS OF YOUR DISKS 
Launch the Norton Utilities by double-clicking on the icon, and 
when the main Norton Utilities window opens, select the Norton 
Disk Editor from the Utilities menu. Because the Disk Editor is 
considered an advanced option, it does not have an icon on the 
main Norton Utilities window. 

When the Disk Editor opens, choose the disk you want to work 
with by clicking on the drive icon or the Drive button, or by typ
ing Command-O; then click on Open when you have chosen the 
drive. The Disk Editor quickly examines the contents of your disk, 
and then opens the Directory window as Figure 17.1 shows. The 
contents of your directory will look a little different. 

The scrollable list in the lower half of the window lists the con
tents of your disk, folders, and documents. The organization of 
your disk is shown in graphical form on the left side of this win
dow. The right side of the window lists the sizes of the data and 
resource forks, the types, the creators, and the dates that the files 
were last modified. Click on an entry to select it, and double-click 
on a folder to toggle the folder open and closed. 
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• Figure 17.1: The Disk Editor Directory window 

USING THE DISK EDITOR BUTTONS 

0 1 

There are five buttons at the top of this window. From left to right 
they are as follows: 

Edit File 
Move the highlight to the file you want to examine, and click on 
Edit File. Alternatively, you can also double-click on the file itself. 
If you choose the Norton Utilities file, you will see a window like 
the one shown in Figure 17.2. 

The file is displayed sector by sector, 512 bytes at a time. At the 
top of the window are indicators of the fi le's absolute position on 
the disk and the position of the displayed sector inside the file. 
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• Figure 17.2: The Edit File window 
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Use the scroll bars to move from sector to sector on the disk or to 
move from sector to sector inside the current file. 

In the main part of the window, the leftmost columns of figures 
show the location of the data in tenns of a byte count (in decimal 
and hexadecimal) from the beginning of the sector. The central 
area of the window shows the data in the fi le as two-digit hex 
numbers. Each line in the window di splays 16 bytes of informa
tion. On the right side of the window, these same 16 bytes are 
shown in ASCII form. Any nondisplayable characters are shown 
in this text portion of the window as dots. 

Both the hex and text parts of this window have their own cursor: 
the block cursor is active, and the underline cursor shows the cor
responding position in the other half of the window. When the 
block cursor is in the hex part of the window, you can edit the file 
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by entering hexadecimal values. When the block cursor is in the 
text part of the display, you can just type a character from the 
keyboard. 

You can move through the data in this window by using the scroll 
bars on the right side of the window or by using the arrow keys. 
When you make a change to one side of the display, the other side 
is updated automatically. Any changes you make in the hex por
tion are automatically displayed in the text area, and vice versa. 

If you make any changes to the file, you will be asked if you want 
to save them when you try to change to another sector or when 
you try to close the window. A dialog box opens asking if you 
want to 

Save changes to this sector? 

Be very sure that you want to write your changes to the disk be
fore you click on Save; otherwise click on Discard or Cancel. 

Edit Info 
Every file and document on your disk possesses certain attributes, 
including whether it is visible on the desktop, whether it has an 
icon, and the time and date that it was created and last modified. 
You can click on Edit Info to look at or to change this information 
for any particular file. Figure 17.3 shows this window for the Nor
ton Utilities file. 

At the top of the window, you will see the file name, the file type 
(APPL for application program, FNDR for Finder, INIT for a 
startup document, cdev for a control panel device, and so on), and 
creator listed. You can change any of these entries by clicking on 
the appropriate box and typing in your new text. 

Editing Your 



' s File Edit Objects Display Information Utilities 

~ ( File l~'nDMIIDDII4 I 
Type~ creator~ 

Edit file E 

Uamt D lnulslble D Locked 1811 nllted r Modlfft d 
~------- -----= Hord D\ok Don Desk D Finder Locked D Changed 

I a tlorto D System D Prot ect ed 0 Dusy 

DEn 181 Bundle OBozo 0 Cached 7/04/91 IQ 
~ lo ONo l nlls D Switch Launch 181 File Open .?.~~ 

+ 
.. '3i .iio 

.. -- ·q;··sp creation Dat e: IJu\11 , 1990 1:00PM I ... !L!'!.L~.!. 
7 /14/9 1 

D tlo Modification Dote: IJul 19, 1991 9:49AM I 
1/18/91 

oa ckup Dote: I Jon I , 1904 0:00AM I 
([OK J)~ 

5 
, PI IQ\?J • 

• Figure 17.3: The Edit info window 

In the center of the window you will see either 9 checkboxes if 
you are working with a fo lder or 15 checkboxes if you are work
ing with a file. These attributes are usually maintained by the 
Finder or by your application programs-there is no need to 
change them under normal circumstances. These checkboxes rep
resent the file attributes, as follows: 

• Invisible. The file or folder is not visible in the Finder or in 
most file dialog boxes. The Desktop file is an example of 
an invisible file. 

• On Desk. The file has been dragged out of its disk or folder 
and placed on the desktop. 

• System. One of a group of special files used by the system. 
The system file, the Finder, and the Clipboard are examples 
of system fi les. You cannot change the name of a file with 
this attribute. 
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• Bundle. This attribute tells the Finder that the file has infor
mation that should be read into the Desktop file. 

• No Inits. This box is checked if an INIT or cdev has no 
INIT resources within it. It is also checked if an application 
program can be opened for read-only use on a network. 

• Locked. This file can be opened and read but cannot be 
changed or modified. You can set this attribute using the 
Finder's Get Info dialog box. 

• Finder Locked. The file cannot be changed or deleted. This 
is set in the Locked checkbox in the Get Info dialog box. 

• Protected. This file cannot be copied, duplicated, or moved. 

• Bozo. This is a residual attribute left over from an early 
form of copy protection; it is no longer used by Apple. This 
attribute is also known as the No-Copy attribute. 

• Switch Launch. Indicates that the system on the disk from 
which this application was originally launched becomes the 
active system. Apple's Installer is an example of a program 
that behaves this way. 

• Initted. This attribute is set by the Finder when it has seen 
the file. 

• Changed. The file has been changed or modified in some 
way. 

• Busy. This attribute is temporarily set when the file is in 
use. 

• Cached. The file is suitable for storing in the RAM cache. 

• File Open. The file is currently open. 

Finally, at the bottom of the window, you will see the file's create 
date, last modification date, and backup date. Click on OK or 
Cancel to dismiss the dialog box. 
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Find 
Click on the Find icon to open a dialog box that allows you to 
search your disk for a specific file. Enter the name or as much of 
the name as you can remember, and then click on Find or press 
Enter. 

Sort 
When you click on the Sort icon, you will see a submenu that 
lets you sort the entries in the Directory window by one of the 
following: 

• by Name 

• by Date 

• by Size 

• by Kind 

• by Type 

• by Creator 

Show Path 
When you click on the Show Path icon, the Disk Editor shows 
you how to get to the currently selected file or folder. You will see 
the file, the folder that the file is in, and so on all the way up to 
the name of the disk itself. 

CHOOSING AN OBJECT 
The Disk Editor can access disk information in several different 
ways. Files can be accessed in terms of name, allocation units, or 
sectors, so the next step in using the Disk Editor is to specify an 
object to work with. 
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If the Disk Editor has the Directory window open when you 
choose a new object, a new window opens to display the informa
tion you have asked for. There is often more information than will 
fit in a specific window, so use the scroll bars to move through the 
data. You can also click on a specific entry in the lower portion of 
each of the following windows to read a brief text description 
of the item. 

Use one of the first seven entries in the Objects menu to specify 
what you want to look at. Choose from the following: 

• Boot Blocks. This displays the information contained in the 
boot block (information that the Mac reads at startup time). 

• Volume Info Block. This area of the disk contains addi
tional information about the disk you are working with. 

• Extents Tree Header. This part of the disk contains infor
mation concerning the layout of files on your disk. 

• Extents B-Tree. This shows the actual contents of the Ex
tents Tree, one node at a time. Click on the Up, Down, 
Left, or Right buttons to move through the nodes on the 
tree. 

• Catalog Tree Header. The Catalog Tree keeps track of all 
the file and folder names and locations. This information is 
used by the Finder. 

• Catalog B-Tree. This shows the actual information kept in 
the Catalog B-Tree. Click on the Up, Down, Left, or Right 
buttons to move through the nodes on the tree. 

• Directory. This is the default Disk Editor window display, 
and it is the mode that the Disk Editor starts up in. 

The next three selections in the Objects menu allow you to select 
the sector you want to view. 
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• Read Previous Sector (Command-<). Reads and displays 
the contents of the previous sector on the disk. 

• Read Next Sector (Command->). Reads and displays the 
contents of the next sector on the disk. 

• Read Sector (Command-R). Use this selection to specify 
the number of the sector you want to read and display. First 
click on either the Decimal or the Hex radio button to tell 
the Disk Editor which numbering system you will be using. 
Then enter a number for one of the following: 

• Sector Number 

• Allocation Block 

• Catalog B-Tree Node 

• Extents B-Tree node 

• Byte Offset within File 

Click on Read to read and display the item you specified, or click 
on Cancel to dismiss the dialog box. 

The final selection in the Objects menu lets you write your 
changes back to your disk again, replacing the original contents 
with your changes. Be careful- this can be very dangerous. 

• Write Sector. Use this selection to write your changes back 
to disk again. 

USING THE DISPLAY MENU 
Once you have chosen the object you want to look at using the 
Disk Editor, you can also choose how you want that object to be 
displayed. 

• Resource Fork. When you look at a file using the Edit File 
icon, choosing Resource Fork displays the file's resource 
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fork if it has one. The resource fork contains information 
on fonts used, dialog boxes, and so on. Not all documents 
have resource forks, but all applications do. 

• Data Fork. When you examine a file using the Edit File 
icon, selecting Data Fork displays the file's data fork if there 
is one. Most documents do have data forks; many applica
tions do not. 

• View in Hex. This selection displays the currently selected 
object in hex on the left of the window and in ASCII on the 
right. 

• View in ASCII. This selection displays the current object in 
ASCII only. The hex byte count shown in the hex display is 
also removed. Nondisplayable characters are shown as 
dots. 

• View As. This selection contains a short submenu that lets 
you change the way that the current object is displayed. 
This is especially useful if the object you are examining is 
badly damaged and you want to look at it using a different 
format. Choose from the following: 

• Boot Block 

• Volume Info Block 

• B *Tree Header 

• Extents Tree 

• Catalog Tree 

• AutoView 

When the Auto View selection is checked, the view changes auto
matically, displaying the object you are looking at in the correct 
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format. If AutoView is not selected, new objects are shown in the 
currently selected format only. 

• Current Folder. This is the default Disk Editor view, and it 
shows a directory listing of the currently selected folder. 

• All Files Flat. This selection ignores the hierarchical struc
ture you have imposed on your disk and shows you all the 
files on your disk as though they were all in the same 
directory. Then you can sort this list by name, date, size, 
and so on. 

• All Files Outline. This selection shows you all fi les in all 
folders and indicates the hierarchical relationships between 
them graphically. 

USING THE INFORMATION MENU 
The Information menu contains two selections: 

• File Information (Command-f). This selection opens the 
same dialog box you see if you click on the Edit Info icon 
at the top of the main Disk Editor Directory window. 

• Disk Information. This selection opens a dialog box show
ing information about the current disk, including its size, 
the amount of used and free space, and the number of files 
and folders on the disk. Click on the close box in the upper 
left to dismiss this dialog box. 

In the next two Steps, we will look at specific ways you can use 
the capabilities of the Disk Editor. 
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Changing File 
Attributes 

This Step concentrates on why you might want to change file at
tributes, and it shows you how to change them using the Disk 
Editor. (Refer back to Step 17 for a detailed description of file 
attributes.) 

USING THE DISK EDITOR 
You can use the Disk Editor to look at or change any of the 
file attributes attached to a file or to a folder. Launch the Norton 
Utilities by double-clicking on the icon, and when the main Nor
ton Utilities window opens, select the Norton Disk Editor from the 
Utilities menu. Place the highlight on the file or folder you want 
to work with in the main Disk Editor Directory window, and 
then click on the Edit Info icon <:tt the top of the window. Alterna
tively, click on the file or folder, and use File (or Folder) Informa
tion (Command-1) in the Information menu to open the window. 
The file attributes are shown as columns of checkboxes in the cen
ter of this window. There are 15 attributes associated with each 



file or document, and 9 of these attributes also apply to each 
folder. The following attributes apply to both files and folders: 

• Invisible 

• On Desk 

• System 

• Locked 

• Finder Locked 

• Bozo 

• Initted 

• Changed 

• Busy 

and the following attributes are associated only with fi les: 

• Bundle 

• No Inits 

• Protected 

• Switch Launch 

• Cached 

• File Open 

The creation date, modification date, and backup date are also as
sociated with both fi les and folders. 

MAKING A FILE OR FOLDER INVISIBLE 
Application programs differ in their response to hidden files; some 
will list them in the standard file dialog boxes and others will not. 
The Desktop file is a common example of a file that is hidden for 
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a very good reason-hiding the file makes it difficult to delete by 
accident. 

To look at the Desktop file, first click on the hard disk icon at 
the top of the scrollable area of the Disk Edit Directory window 
and change to the root level of the hard disk. In the list of files and 
folders, you will see a file called Desktop with a creator called 
ERIK and a type called FNDR. Now click on the Edit Info icon to 
list all the attributes for this file. Note that only the Invisible 
checkbox is checked for this file. 

You can use Edit Info in the Disk Editor to change the hidden at
tribute on a file, but you should resist the temptation to make too 
many files hidden, as the saying "out of sight, out of mind" will 
become painfully evident. There is little point in hiding applica
tions, as you will forget them, and other people will be unable to 
use them. If your disk is getting cluttered with applications that 
you do not use, don't hide them. Instead, copy them to a floppy 
disk so that you can recover the disk space for something more 
useful. 

CHANGING OTHER FILE ATTRIBUTES 
When a document is created, its creator and type are specified by 
the application program that made it. The creator is a four-letter 
code that identifies the application. Creator codes are registered 
with Apple so that no two applications will assign their files the 
same creator code. The F inder uses this code to associate docu
ments with their applications. This is how it is possible to double
click on a document and have the correct application loaded. 

The file type is another four-letter code identifying the format of 
the file. This code enables applications to list only the files that 
they can work with when you use the standard file dialog boxes to 
open or save files. Folders do not have file types or creators. 
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You can use the Disk Editor to look at or change either or both 
of these codes. Place the highlight on the file you want to work 
with in the Disk Editor Directory window, and then click on 
the Edit Info icon at the top of the main window. Alternatively, 
place the highlight on the correct file, and use File Information 
(Command-1) in the Information menu to open the window. The 
file type is shown at the top left, and the file creator is shown at 
the top right of the window directly under the file name box. 

There are two reasons why you might want to modify these at
tributes. First, if an application assigns the fi le type or creator in
correctly, or if the attributes are lost or damaged in some way, you 
may have to correct them manually. Second, if you modify the file 
type, you allow different applications to open or try to open the file. 

If you want to read a Microsoft Word fi le but don't have the appli
cation on your Macintosh, you can change the file type from 
WDBN to TEXT, and then any text editor, even TeachText, can 
open the file and read it. All the formatting information in the file 
will be lost of course, and some garbage may appear in its place, 
but the basic text information would be available. In any case, ed
iting the garbage out of a text file is usually a lot faster than retyp
ing the entire document. 

Also, if you have a word processor document that is damaged so 
that you cannot open it with the original application, you may be 
able to recover some information from t11e file if you convert it 
from its original type into a TEXT document. 

Similarly, changing the file type on a bit-mapped graphic fi le to 
MPNT (MacPaint) is an often-used trick. 

There is no advantage to manipulating most of the other file at
tributes; they are there for a specific purpose, and changing them 
may make some unexpected and possibly unpleasant things happen. 
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Searching for 
Data 

You can use the Disk Editor to search for specific files on your 
di sk, but you can also use it to look for text strings inside those 
files. This means that you can locate documents from their con
tents rather than by their names. 

Just like the Norton Di sk Doctor, the Disk Editor was not de
signed to work with the older l\1FS (Macintosh File System) disks, 
and if you try to mount such a disk, the Disk Editor responds with 
an error message. 

USING FIND 
If you are in the main Disk Editor Directory window, you can 
click on the Find icon, or use Find (Command-F) in the Edit menu 
to open the dialog box shown in Figure 19 .1. 

Enter the name of the file you want to search for, or alternatively, 
just enter a few characters if you want to make the search more 
general. For example, you can enter nort into this dialog box to 
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• Figure 19.1: Enter the name of the fife you want to search for into the 
dialog box 

find all the files with those four characters in the file name, and 
the Disk Editor wiU list all the files that have nort as part of 
their name. 

Find changes slightly if you are using one of the other windows 
instead of the Directory window. For example, if you have chosen 
Boot Blocks from the Objects menu, and Auto View in the Display 
menu is turned on, you will see the information in the Boot 
Blocks displayed in its native format on your screen. Now if you 
select Find from the Edit menu, a different dialog box opens, this 
time asking you to type in the text string you want to search for, as 
shown in Figure 19.2. 

Enter your search string in ASCII into the upper box, or enter the 
string directly in Hex into the lower box. However you choose to 
enter the search string, it is converted into the other system and 
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• Figure 19.2: Enter your search text into either the ASCII or the Hex box 

displayed in both boxes at the same time. Check the Ignore Case 
checkbox to search for upper- and lowercase equivalents of your 
string. 

Click on Find or press Enter to start the Disk Editor searching the 
current object for the string you entered. When the search string is 
found, you can use Find Again (Command-A) in the Edit menu to 
repeat the search as many times as you like. 

If you try to edit a file that is fragmented into too many pieces for 
the Disk Editor to handle, you may see the message 

Warning: that file is too fragmented to 
search . Run SpeedDisk to defragment your disk. 

You should follow the advice given in the message and consoli
date your files using SpeedDisk. 
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The other selections in the Edit menu remain grayed out and are 
unavailable in the Disk Editor. 

USING THE FILE MENU 
You can use the first three entries in the File menu to open and 
close files and volumes, as follows: 

• Open File (Command-O). You can use this command to 
choose a file from a Directory Assistance open dialog box, 
as shown in Figure 19.3. 

You can choose to open either the data fork or the resource 
fork in this dialog box, even though the data fork is the 
default setting. Click on Cancel to dismiss the dialog box. 

• Open Volume. Use this selection to open a new disk, or 
volume. A standard disk selection dialog box opens where 
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• Figure 19.3: Select a file to open from the Directory Assistance 
dialog box 
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you can click on the drive icon or the Drive button, or type 
Command-D to cycle through all the disks connected to 
your system. 

• Close (Command-W). Use this selection to close the cur
rent window when you have fini shed working in it. This is 
the same as clicking on the close box in the upper left 
comer of the window. 

The remaining entries in the File menu are the usual Page Setup 
and Print selections. 

At the end of your Disk Editor session, click on Quit (Com
mand-Q) from the File menu and you will return to the Finder. If 
you have made changes to a file and not saved them, the Disk Edi
tor opens a dialog box asking if you want to 

Save changes to this sector? 

The Disk Editor will not let you exit if you still have some unfin
ished editing. Click on Save to write your changes back to disk; 
click on Discard to abandon your changes, quit the Disk Editor, 
and return to the Finder; or click on Cancel to dismiss the dialog 
box. Choose one of other programs from the Utilities menu if you 
want to work with one of the other Norton Utilities, or choose 
Main Menu to go to the main Norton Utilities menu window. 
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Rebuilding 
Your Desktop 

The Desktop fi le is an ordinary Macintosh file used by the Finder 
to store information about all the other files and folders on the 
disk. It holds icons and information from the BNDL resource of 
applications whose Bundle bit was set, as well as the Get Info 
comments from all of those files. The Desktop file also keeps 
track of all open folder and disk windows and their posi tions. 

The Desktop file is an invisible fi le and is not displayed during 
nonnal Finder operations, although you can see it if you use the 
Disk Editor. The fact that it is invisible makes it very difficult to 
delete by accident. 

Each time you access a disk, or alter or modify a file, document, 
or folder, the Desktop ftle is updated. The Desktop file is accessed 
each time a disk first appears on the desktop, and again when the 
Finder returns to the desktop. 

The Desktop file was designed before the Macintosh could use 
a hard disk, before the HFS (Hierarchical Fi ling System), and 



before the Macintosh could access large numbers of files. The 
common use of larger and larger hard disks has imposed a terrible 
strain on the Desktop file, and this has made it very slow and the 
source of many problems. Because of this, the Desktop file will 
probably be replaced in later versions of the Macintosh system 
software. 

As you work with your Macintosh by adding, modifying, and re
moving files, the Desktop file can become more and more frag
mented, slowing down its operation. It is possible that the file can 
be damaged so that the Finder forgets which application a docu
ment belongs to. You may see the message 

The file <name> could not be opened/printed 
(the application is busy or missing) . 

when you know that the application is neither busy nor missing. 

Because the Desktop file plays such an important role in proper 
operation of the Finder and other system software, a damaged 
Desktop file can cause a variety of other problems, and you may 
see the 

Disk has minor problems, do you wish to repair 
it? 

dialog box. When this happens, you are really being asked if you 
want to rebuild the Desktop file. If you answer yes to this ques
tion, the Macintosh actually recreates the Desktop file from 
scratch. 

You can also rebuild the Desktop file yourself if you hold down 
both the Command key and the Option key as you turn on your 
Macintosh. Some of your startup documents may be interrupted 
by this key sequence; click on the appropriate buttons and 
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continue to hold down the Command and Option keys. After the 
Welcome to Macintosh message, a dialog box opens with the 
message 

Are you sure you want the desktop rebuilt on 
the disk "Hard Disku? (Thi s may take a few 

minutes.) 

as Figure 20.1 shows. 

Click on OK to recreate the file, or click on Cancel to dismiss the 
dialog box. It usually takes two to three minutes to remake 
the Desktop file because the Finder has to read every ftle on 
your disk. 

The new, unfragmented Desktop file will be read much faster, and 
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• Figure 20.1: This dialog box appears if you hold down the Command 
and Option keys as you restart your Macintosh 
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when you return to the desktop, it will appear more rapidly than 
before unfragmentation. So remember, if your Macintosh is grow
ing sluggish, rebuild your Desktop file. 

USING FORMAT RECOVER 
AFTER REBUILDING THE DESKTOP FILE 
Rebuilding the Desktop file makes the desktop appear more 
quickly, but it also destroys any comments you have added to your 
document's Get Info boxes. If you installed FileSaver before you 
rebuilt t11e Desktop file, you can use Format Recover to restore 
these comments. 

If you want to restore the Finder's Get Info comments to your 
startup disk, remember to launch the Norton Utilities from tlle red 
Emergency disk; you cannot use Format Recover on your startup 
disk. Choose the Format Recover icon in the main Norton Utilities 
window, and in the next dialog box, click on the Restore Finder 
Comments radio button at the bottom of the dialog box. Then 
click on OK. The next dialog box asks you which disk you want 
to restore the Desktop comments on. C lick on the drive icon or 
Drive button, or press Command-O to change to the correct drive, 
and tllen click on Open. A dialog box opens showing tlle progress 
of the search for Finder comments. When the process is complete, 
you return to tlle main Norton Utilities menu window. 

The next time tllat you use the Finder's Get Info command on a 
particular document, you will see that your comments have been 
reinstated in full. 
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A 
allocation of files, checking, 62 
animated pencil display with 

Speed Disk, 114 
appending recovered files, 105 
application files 

launching, 39-40 
recovering, 95, 102, 104 

Applications disk, 5 
arrow keys, 10, 15 
ASCII characters 

codes for, 44-45 
in disk contents displays, 

124-125, 131 
in text searches, 103, 138 

attributes, 125-127 
changing, 133-136 
with Desktop, 51-52 

8 
backups 
of distribution disks, 2-5 
with Speed Disk, 111 

bad blocks, 117 
BNDL resource, 143 
bookkeeping information, 
checking, 118-119 
bookmarks, 14, 16-17 
boot blocks, 129 
bozo attribute, 127, 134 
browsing through files, 35-37, 

101-107 
bundle attribute, 127, 134 
busy attribute, 127, 134 

Index 

c 
cable problems, 68 
cached attribute, 127, 134 
case sensitivity with searches, 

17,34, 103,139 
catalog tree 

and deleted files, 82 
editing, 121 
headers for, 129 

categories of files, recovering, 
95-96 

changed attribute, 127, 134 
characters 

displaying, 41-46 
editing, 46-48 

cleaning up and icon spacing, 55 
clicking mouse, 9 
Clipboard, 47-48 
color 

with desktop, 52 
installing, 6-7 
memory for, 71 
with Speed Disk, 116-117 

configuring 
DiskLight, 29-31 
FileSaver, 20-21 
Finders, 53-54 
UnErase search criteria, 

96-100 
connector problems, 68, 70-71 
contiguous free disk space, 119 
Copy command, 47-48 
copy-protection and Speed 

disk, 111 



copying 
distribution disks, 2-5 
Finder characteristics, 54 
text, 47-48 

creator 
codes for, 135-136 
displaying files by, 87, 128 

cross-linked files, 62 
cursor, 9 
customizing 

Desktop, 49-58 
during installation, 6 

Cut command, 47 

D 
damaged disks and files 

checking for, 62 
Desktop, 144 
recovering, 67-7 1 

data forks, 130-13 1, 140 
date 

displaying files and folders 
by,26,87, 128 

formats for, 57-58 
decimal values 

for ASCII characters, 45 
for disk contents dis

plays, 124 
for sector writing, 130 

default settings, 6-7 
wi th desktop, 52 
for Finders, 52-53 
for spacing, 57 
for views, 57 

deleting fi les and folders, 25, 
81-82 

protection with, 79 
recovering from, 83-91 

Desktop 
customizing, 49-58 
moving files to, 39 
rebuilding, 143-146 

diagnoses 
with Norton Disk Doctor, 

61-63 
with Speed Disk, 113 

directories, 62, 129 
DirectoryAssistance,2, 5, 23-27 
Disk Doctor. See Norton Disk 

Doctor 
disk drives, selecting, 6, 11, 

33-34 
Disk Editor. See Norton Disk 

Editor 
Disk.Light, 2, 5, 29-31 
disks. See also files 

for backups, 2-5 
damaged, recovering, 67-71 
displaying sectors on, 

123-125, 129- 130 
editing. See Norton Disk 

Editor 
formatting, 22, 74 
monitoring access, 29-31 
reports for problems on, 

63- 65 
testing, 59-63 
for unerasing files, 89 
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unfonnatting, 73-80 
unfragmenting. See Speed 

Disk 
displaying 

characters, 41-46 
disk contents, 122-125, 

129-130 
edited objects, 130--132 
files and folders, 25-26, 

35-36,55-56,85-88,128 
distribution disks, copying, 2-5 
double-clicking mouse, 9 
duplicating files and folders, 25 

E 
easy level for Speed Disk, 

112-114 . 
Edit menu with desktop, 54 
editing 

characters, 46-48 
disks. See Norton Disk Editor 

Emergency disk 
for damaged hard disks, 

68-69 
for Finder, 71 
and Fonnat recover, 75 
help on, 67 
and installation, 3, 5-6 
for UnErase, 83-84, 93 

End key, 10, 15 
Enter key, I 0--11 
Erase Disk command, 74 
Escape key, 11 
expert level for Speed Disk, 

114-118 

exploring with Speed Disk, 
118-119 

extents trees 
editing, 121 
headers for, 129 

F 
Fast Find, 2, 5 

for browsing through files, 
35-37 

for finding files , 33-35 
for launching applications, 

39-40 
for moving files to Desktop, 39 
for searching through folders, 

37-39 
File menus 

for customizing desktop, 
53-54 

and Directory Assistance, 
24-25 

for searches, 140--141 
file open attribute, 127, 134 
files. See also disks 

adding, 82-83 
attributes for, 125-127, 

133-136 
browsing through, 35-37, 

101-107 
deleting, 25, 81-82 
Directory Assistance for, 

23-27 
displaying, 25-26, 35-36, 

55-56,85-87,128 
duplicating,25 



editing. See Norton Disk 
Editor 

FileSaver, maximum, 21 
finding, 33-35 
fragmemed. See fragmented 

files, Speed Disk 
hidden, 111, 134-135 
information on, 25, 85-88 
moving, to Desktop, 39 
opening, 24, 140 
protecting, 79 
recovering. See recovering 

files 
searching for, 25, 33-35, 128 
sorting,25-26,87, 128 
status of, 65 

FileSaver, 2, 5, 19-22 
creating files for, 79 
with UnErase, 85-90 
and unformatting, 75-77 
updating, 80 

Find command, 137-140 
Finders 

configuring, 53-54 
and Norton Disk Doctor, 7 1 

finding. See searching 
floppy disks 

for backups, 2-5 
damaged, recovering, 69-70 
formatting, 22, 74 
launching utilities from, 5 
monitoring access, 29-31 
unerasing files on, 89 

folders 
attributes for, 51-52 

creating, 24 
deleting, 25 
Directory Assistance for, 

23-27 
displaying, 25-26 
duplicating, 25 
finding, 33-35 
searching through, 25, 37-39 

fonts 
for characters, 4 1-48 
for desktop, 52-53 

foreign language characters, 41 
Format Recover, l , 5, 73-74 

for Desktop file, 146 
using FileSaver, 19, 21-22, 

75-77, 79-80 
without FileSaver, 77-79 
for Get Info comments, 

79-80 
formats for dates, 57-58 
formatting 

and FileSaver, 22 
high-level and low-level, 74 
recovering files after, 73-80 

fragmented fi les, 83 
Desktop, 144-145 
editing, 139 
finding parts of, 104-106 
optimizing. See Speed Disk 
recovering, 22, 98 

G 
Get Info comments 

and Desktop fi le, 143, 146 
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and FileSaver, 19,21 
saving, 79-80 

global searches of help system, 
17-18 

glossary, 13, 15-16 
grids 

for Desktop, 50 
for icons, 55, 57 

groups of files, unerasing, 
93-100 

H 
hard disks 

for backups, 3-5 
damaged, recovering, 68-69 
installation onto, 5-7 
monitoring access, 29-31 
unerasing files on, 89 
unformatting, 73-80 
unfragmenting. See Speed 

Disk 
hardware problems, 68, 70 
help system, 13-18 

on Emergency disk, 67 
installing, 6-7 

hexadecimal values 
for ASCII characters, 45 
for disk contents displays, 

124-125, 131 
for sector writing, 130 
for text searches, 103, 138 

hidden errors, 65, 69 
hidden files, 111, 134-135 
Hierarchical File System, 59 

hierarchy, checking, 62 
high-level formatting, 74 
Home key, 1 0, 15 
hotkey sequences, 10-11 

I 
icons, 55-57 
information for files, 25, 85-88 
Information menu for Disk 

Editor, 132 
initted attribute, 127, 134 
installation, 5-7 

of disk protection, 79-80 
and file recovery, 3, 5-6 

interface, 9-11 
invisible attribute, 126, 134 

K 
KeyFinder, 2, 5, 41-48 
keystrokes, shortcut, 10-11, 

26-27 
kind, displaying files by, 

87, 128 

L 
laser printers, 46 
launching 

applications, 39-40 
Format Recover, 75 
Norton Disk Doctor, 60 

LayoutPius,2,5,49 
Edit menu in, 54 
File menu in, 53-54 



Special menu in, 50-53 
View menu in, 54--58 

listing. See displaying 
lists, scrollable, 10 
locked attribute, 127, 134 
logical formatting, 74 
lost files, 62 
low-level formatting, 22, 74 

M 
Macintosh File System, 59, 137 
maps for Speed Disk, Il2 
memory 

for color, 6 
for Norton Disk Doctor, 7I 
for Speed Disk, 111 

mouse, 9 
moving files to Desktop, 39 
MultiFinder and Norton Disk 

Doctor, 71 
multiple disk errors, 65, 69 
multiple UnErase sessions, I 06 

N 
names 

displaying files and folders 
by, 25,56, 128 

for recovered files, 105 
networks, 60 
no-copy attribute, 127 
no inits attribute, 127 
Norton Disk Doctor, I, 5 

for damaged disks, 67-7I 
and MultiFinder, 71 

for testing disks, 59-66 
Norton Disk Editor, I, 5, 

121-I22 
buttons with, 122- 128 
for creator and type codes, 13 6 
displaying objects with, 

130-132 
for file attributes, I33-134 
selecting objects with, 

128-130 
text string searching with, 

137-140 
Norton Guide hypertext display 

database, 13 

0 
octal values for ASCII charac-

ters, 45 
on desk attribute, 126, 134 
online help, installing, 6-7 
open windows, maximum 

number of, 52 
optimizing hard disks. See 

Speed Disk 
orientation of Key Finder 

display, 44 

p 
page searches with help system, 

17-18 
Paste command, 48 
paths, displaying, 128 
pause time for wristwatch 

icon, 52 
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pencil display with Speed 
Disk,114 

performance and Speed 
Disk,113 

PgUp and PgDn keys, 10, I5 
physical formatting, 74 
position of windows, 57 
printing 

Key Finder information, 
46-47 

Norton Disk Doctor reports, 
63--65 

prioritizing files with Speed 
Disk, II6--I17 

program fi les 
launching, 39-40 
recovering, 95, 102, 104 

Programmer Mode for Key
Finder, 45-47 
protected attribute, 127, 134 
protection 

of disks, 79-80 
FileSaver for, 19-22 

R 
radio buttons, I I 
Read Me files, 7-8 
reconstructing hard disks, 78 
Recovered Files fo lder, 90, 99 
recovering files 

application, 95, 102, 104 
from damaged disks, 67-71 
deleted, 83-91 

fragmented, 22, 110 
groups of, 93-100 
from hard disk formatting, 

73-80 
and installation, 3, 5-6 
single, 83-91 
text search for, 10I-107 

red Emergency disk. See 
Emergency disk 

Redo command, 54 
related help topics, 15 
reports from Norton Disk 

Doctor, 63--65, 69 
resource forks, 130-131, 140 
restoring 

s 

fonnatted disks, 76--77 
Get Info comments, 80 

saving reports, 69 
scanning for file types, 93-96 
scroll able lists, I 0 
scrolling text files, 36 
SCSI bus problems, 70-71 
searching 

case sensitivity with, 17, 34, 
103, 139 

with File menu, 140-14I 
for file types, 93-96 
for files, 25, 33-35, 128 
folders, 37-39 
help system, 17-18 
sectors, 98 
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for special characters, 43-44 
for text strings, 101- 107, 

137-140 
sectors, 1 09 

displaying,123-125, 129-130 
searching, 98 

shortcut keys, I 0-11, 26-27 
size 

of desktop letters, 53 
displaying files and folders 

by, 26, 87, 128 
of windows, 56 

Small Computer System 
Interface bus problems, 
70-71 

sorting files and folders, 
25-26,87, 128 

spacing of icons, 55, 57 
special characters, 43-44 
Special menu for customizing 

Desktop, 50-53 
Speed Di sk, 2, 5, 109 

easy level with, 112-114 
expert level with, 11 4-11 8 
exploring with, 118- 199 
precautions wi th, 11 0-11 1 
running, 111- 112 

summary disk problem 
reports, 65 

switch launch attribute, 
127, 134 

system attribute, 126, 134 
system information, reports for, 

64-65 

T 
TeachText, 8 
tests, Norton Disk Doctor 

61-63 ' 
text and text files 

copying, 47-48 
for disk contents displays, 125 
for recovered fragments and 

files, 98, 105 
searching for, 101-107, 

137-140 
viewing, 36-37, 88 

TEXT documents, 136 
Text Edit for characters, 46-48 
topics, help, 13, 15 
trash warning, 50-5 1 
trashcan, 81-82 
truncated text, 56 
Turbocharge Speed Disk 

option, 117 
type of files 

codes for, 135-136 
displaying by, 87, 128 
scanning for, 93-96 

u 
Undo command, 54 
UnErase, 1, 5, 77-78 

and FileSaver, 19,21-22 
for groups of files, 93-100 
for single files, 83-91 
text search with, 101- 107 

Up & Running with Norton Utilities on the Macintosh 
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unformatting hard disks, 
73-80 

unreadable disks, recovering, 
67-71 

updating 
Desktop file, 143 
FileSaver files, 80 

user interface, 9-11 

v 
verifying blocks with Speed 

Disk, 11 7 
View menu 

for customizing desktop, 
54-58 

and Directory Assistance, 
25-26 

viewing. See displaying 
virtual memory with Speed 

Disk, Ill 
virus detectors, 7 
volume information 

checking, 61 
viewing, 129 

volumes 
opening, 140-141 
protecting, 79 

w 
windows, size and position of, 

56-57 
wristwatch icon, pause time 

for, 52 
write-pro tecting disks, 3, 5 
writing sectors, 130 

z 
zooming windows, 50 



Selections from 
The SYBEX Library 

APPLE/MACINTOSH 

ABC's ol Excel on the Macintosh 
(Second Edition) 
Dougl as Hergert 
334pp. Rei. 634·0 
Ne.,~y uodated to onclude versoon 2.2. tnis 
tu!oroal oilers a qu·ck way lor begonners to 
get s:arted dorng uselul work \'lllh Excel. 
Readers buold oractocal examples lor 
accounting, management. and hamel 
ollice appl cat ens, as :hey learn lo creare 
1\'0rksheers cnans. darabases. macros. 
and more 

Desktop Publishing with 
Microsoft Word on the 
Macintosh 
(Second Edition) 
Tim Erickson 
William Flnzor 
525pp. Rol. 601-4 
The aulhors have woven a murder mys
rery through the text. using the sample 
publicatoons as clues Explanaroons ol 
page layout, headrngs. lonrs and styles. 
columnar texr. and graphics are interwo
ven within the mystery theme at !his excit
ong reacning method. For Versoon 4 0. 

Encyclopedia Macintosh 
Craig Danuloff 
Deke McCl elland 
650pp. Ret 628-6 
Just what every Mac user needs-a com
plete reference to Macrntosh concepts 
and trps on system sohware hardware 
applications. and troublesnoo:ong 
Instead at Chaprers. each sectoon os pre
senred in A-Z Ierma! wrth user-lriendly 
icons leading tne way 

Mastering Adobe Illustrator 
David A. Holzgang 
330pp. Rei 463-1 
This texl provides a comp'ete introduclion 
to Aaobe lllustra:or, brongong new sophosti 
catoon to artos:s usong computer-aided 
graphocs and page design technology. 
Includes a lock at Pos!Scropt. !he page 
ccmposotoo1 language used by lllus!ra:or 

Mastering AppleWorks 
(Second Edition) 
Elna Tymes 
6 79p:> Rei 398·8 
New chapters 01 bus.ress apo ocabcns, 
data sharong DIF and Applesoft BASIC 
make th•s practical. on-depth tutoroal even 
better Full de:arls on AppleWorks 
desktop, word processong, spreadsheet 
and database funcroons. 

Mastering Excel 
on the Macintosh 
(Third Edition) 
Carl Townsend 
656pp Rof. 622· 7 
Thos highly accla•med tu:oroal has been 
updated lor the latest version of Excel 
Full of extensove examples. toos. apploca
toon templaJes. and ollus:ratoons. This boo< 
makes a great relerence for usong work
sheers, databases. g raphics. charts. 
macros. and tables. For Verson 2.2 

Mastering Microsoft Word on 
the Macintosh 
Michael J. Young 
447pp. Ref 541 -7 
Tnos ccmprerensove. step·by·step guode 
shows tne reader through WORD's eXlen
sive capabilities, from base edllng locus
lom lormats and desktop pubhshing 



Keyboard and mouse instruct ions and 
practrce exercises are included For 
Re1ease 4 0 

Mastering Powerpoint 
Karen L. McGraw, Ph.D. 
425pp. Ref. 646-4 
The complete gUide to creatmg hrgh
quahty graphrc presentatrons usrng 
PowerPomt 2 0 1 on the Macrntosh
offeung detailed. step-by-step coverage 
of everythmg from starting up the soh
ware to fine-tunrng your slide shows for 
maximum effect. 

Mast ering Ready, Se t, Go! 
David A. Kater 
462pp. Ref. 536·0 
Thos hands-on rntroduction to the popular 
desktop publish,ng package for the Mac
mlosh allows readers to produce 
professional-lookmg reports, brochures, 
and llyers. Written for Version 4 this title 
has been endorsed by Leaaset the 
Ready Set, Go! soflware p ublrsher. 

Understanding Hard Disk 
Management on the Macintosh 
J . Russell Roberts 
334pp Re!. 579·4 
This is the most comprehensive and acces
Sible gurde to hard disk usage for all Macin
tosh users. Complete coverage includes 
SCSI and serial dnves and polls, formaltl'lQ, 
fie fragmen:atK>n, backups. netwmks. and a 
helpful d agnostrc appendrx 

Understanding HyperCard 
(Second Edition) 
Greg Harvey 
654pp Ref. 607·3 
For Mac users who want dear-cut steps to 
qurck mastery of HyperCard this thor
ough tu1orial introduces HyperCard from 
the Browsing/Typrng and Authoring/ 
Parntrng levels all the way to Scrrptrng wrth 
HyperTalk. the HyperCard programmrng 
language. No prror programming experi
ence needed For Version 1 2. 

Using the Macintosh 
Toolbox with C 
(Second Edition) 
Fred A. Huxham 
David Burnard 

Jim Takatsuka 
525pp Ref. 572-7 
Learn to program woth the latest versrons 
of Maantosh Toolbox uStng thrs dear and 
succrnct rntroductron This popular trUe 
has been revised and expanded to 
include dozens of new programmrng 
examples for windows, menus. controls, 
alert boxes, and disk 110 Includes hierar· 
chrcal trle system, Lrghtspeed C. 
Resource files and A Maker 

UTILITIES 

Mastering the Norton Utilities 5 
Peter Dyson 
400op. Ref 725·6 
Thrs complete gurde to rnslalhng and 
usrng the Norlon Utif,tres 5 rs a musl 101" 
begrnning and experrenced users ahke. II 
offers a dear detarled descriplion of each 
ulilty, l'lllh op:rons uses and examples
so users can qurckly identrly the pro
grams they need and put Norton rrght to 
work lndudes valuable coverage of lhe 
newest Norton enhancements. 

Mastering PC Tools Delu xe 6 
For Versions 5.5 and 6.0 
425pp, Ref. 700·2 
An up-Io-date gurde to 1he hlesaving utrh
tres rn PC Tools Deluxe verSion 6.0 from 
rns:allat,on, to hrgn-speed back-ups. data 
recovery, frle encryptron. desktop applica
trons. and more. Includes detailed back
ground on DOS and hardware such as 
floopres hard disks, modems and fax 
cards. 

Mastering SideKick Plus 
Gene Wefsskopl 
394pp Ref. 558-1 
Emoloy all of Srdekrck's powerful and 
expanded fealures l'r.lh lh.s hands-on gotda 
to tne populai UUbty. Features rnclude com
prehenSive and deta.:ed coverage of time 
management note taking, oulbnrng, auto 
dra rng, DOS fi'e management. math. and 
copy·and-pas;e tunctons. 

Up & Running with Norton 
Utilities 
Rainer Bartel 



140oo Ref. 659·6 
Get up and runn1ng 1n the snortest pos· 
sible lime 1n jus1 20 lessons or "steos." 
Learn to restore disks and hies. use 
UnErase. edit your floppy drsks. retneve 
lost data and more Or use tne book to 
evalua:e :he software be'ore you our· 
chase. Tnrough Vers1on 4 2 

Up & Running with PC Tools 
Deluxe 6 
Thomas Holste 
180pp Ref.678-2 
Learn 10 use thrs soltware program 1n lUSt 
20 basic steps Readers get a qu1ck. inex
penSive '"lroduct1on to usrng the Tools for 
d1saster recovery. d sk and toe manage
ment. ard more 

AMIGA 

Amlga Programmer's Handbook, 
Volume I (Second Edition) 
Eugene P. Mortimore 
624pp. Ref. 367 8 
The comp'ete reference 'or Amrga graph
ics programm1ng. System commands 
and function calls are presented rn detail, 
organrzed by funcilonal Class· Exec. 
GraphiCS, Anrmat10n, Layers, lnturtron 
and tne Workbench. InCludes AmrgaOOS 
version 1 2. 

Amiga Programmer's Handbook, 
Volume II 
Eugene P. Mortimore 
365pp. Ref. 384·8 
In-depth discussion of Am1ga devrce 110 
programm1ng-rncluding programm1ng 
wrth sound and speech-\\ith comp'ele 
deta Is on the twelve Amiga devoees and 
the.r associated commands and 'unc;.on 
calls. Indues AmigaDOS vers•on 1.2 

HARDWARE 

From Chips to Systems: An 
Introduction to Microcomputers 
(Second Edition) 
Rodnay Zaks 
Alexander Wolfe 

580pp. Rei. 377-5 
The best·seling rntroductoon to microcom
puter hardware-now 'ully updated. 
•evrsed, and rllustrated. Such recent 
advances as 32·bt processors and RISC 
archlteaure are Introduced and explained 
lor the first tme on a begtfllllng text 

Microprocessor Interfacing 
Techniques (Third Edition) 
Austin Lesea 
Ro dnay Zaks 
456pp Ret. 029·6 
Th1s handbook os for eng1neers and hob
bylsls ahke. covering every aspect of 
rn:er'acrng mrcroprocessors wrth penph
eral devrces. Toprcs rnd udc assembling a 
CPU, basrc flO, analog corcurtry, and bus 
standaros 

The RS-232 Solut ion 
(Second Edition) 
Joe Campbell 
193pp Ref. 488· 7 
For anyone wantrng to use their com
puler's serial pori, this ccmplcte how-to 
gurde rs updated and expanded for 
trouole-free AS-232-C rnterfacmg from 
scratch So'ution shows you how to con
nect a var1ety of co'Tlpu!ers onnters. and 
modems. and rt rncfudes details for IBM 
PC AT. PS/2, and Macrntosh 

OPERATING SYSTEMS 

The ABC's of DOS 4 
Alan A. Miller 
275pp Rei. 583-2 
Thrs step-by-step rntroduction to usrng 
DOS 4 rs wrrttcn especrally for beginners. 
Filled W>tn s mple examples. The ABCs of 
DOS 4 covers the basrcs of hardware, 
sohwaro, d1sks. the syslem ed1lor EDLIN. 
DOS commands. and more. 

ABC's of MS-DOS 
(Second Edition) 
Alan A. Miller 
233pp. Ret. 493·3 
Th•s handy gurdo to MS-DOS is all many 



PC users need to manage the11 computer 
l1les. organize lloppy and hard disks, use 
EDLIN. and keep the.r computers orga· 
nized. Additional information IS given 
about ut1h~es like Sidek1ck, and there IS a 
DOS command and orogram summary 
The second od1lion 1S fully updatl'd lor 
Vers1on 3.3 

DOS Assembly Language 
Programming 
Alan R. Miller 
365pp. 487-9 
This book covers PC-DOS through 3.3. 
and gives dear explanations ol how to 
assemble, link, and debug 8066, 8086. 
60266. and 80366 programs. The 
example assembly language routines are 
valuable for students and programmers 
alike. 

DOS Instant Reference 
SVBEX Prompter Series 
Grog Harvey 
Kay Yarbo rough Nelson 
220pp. Ref. 477·1, 4 "14' x 8" 
A complete fingemp re'erence for fast, easy 
on-line help.command sum;naries, syntax, 
usage and err()( messages. OrganJZed by 
lunctron-system commands, file com
mands, disk managemen~ d11ectories 
balch lies. 110. networking, programmng 
and more Through VefSIOn 3 3. 

Encyclopedia DOS 
Jud d Robb ins 
1 030pp. Ref. 699-5 
A comprehensive reference and user's 
guide to all versrons of DOS through 4.0. 
Offers complete information on every 
DOS command. with all possible swotches 
and parameters-plus examples of effec· 
t1ve usage. An 1nvaluable toot 

Essential OS/2 
(Second Edition) 
Judd Robbins 
445pp. Ref. 609-X 
Wrrtten by an OS/2 expert, thrs is tho 
guide to the powerful new resources or 
the OS/2 operating system standard edi· 
tion 1. 1 wrth presentation manager. Rob· 
bins introduces the standard ed tron, and 
details multrtaskrng under OS/2. and the 
range of C()(hmands for installing, S1anong 

up. conliguring, and running applications. 
For Version 1. 1 Standard Edition 

Essential PC-DOS 
(Second Edition) 
Myrll Clement Shaw 
Susan Soltis Shaw 
332pp Ref. 413-5 
An aull10f<ta!Ive glicle to PC-DOS, induding 
version 3.2. DeS1gned to make experts out 
of beginners. it explores everything from 
disk management to batch hie program
ming. lndudes an 85-page command sum
mary. Through Version 3.2. 

Graphics Programming 
Under Windows 
Brian Myers 
Chris Doner 
646pp Ref. 448-8 
Straightforward discussron, abundant 
examples. and a concise reference gu cle 
to graphrcs commands make this book a 
must for Windows programmers. Topics 
range from how W1ndows works to pro
gramming for bu~ness. ammatron, CAD, 
and desktop publish1ng For Version 2. 

Hard Disk Instant Reference 
SYBEX Prompter Series 
Judd Robbins 
256pp Ref. 587-5, 4 "14 ' x 8" 
Compact yet comprehensive, th1s pocket
sized reference presents the essential 
rnformalion on DOS commands used rn 
managing directorres and l1les, and in 
optimizing d isk configuration. Includes a 
survey of third-party utrlity capabihtres. 
Through DOS 4 .0. 

Inside DOS: A Programmer's 
Guide 
Michael J. Young 
490pp. Ref 710-X 
A collection of practrcal techn.ques (wr:h 
source code listings) designed to help 
you lake advantage ol the rich resources 
intrinsic to MS-DOS machrnes. Designed 
for the expe11enced programmer woth a 
basic understanding of C and 8066 
assembly language. and DOS fundamen
tals. 

Mastering DOS 
(Second Edition) 



Judd Robbins 
722pp Rei. 555-7 
"The most useful DOS book ... Thts seven
part. tn-depth tutonal addresses 1ne 
needs of users at all levels. Topocs range 
I rom running aopl catoons. 10 manag·ng 
Mes and direc:ones. co,rogunng the sys· 
tem. batcn file programmtng. and tech· 
ntques lor sys:em deve opers Through 
Verson 4, 

MS-DOS Power User's Guide, 
Volume I 
(Second Edition) 
Jonathan Kamin 
462pp. Re'. 473-9 
A fully revosed exoanded edttton ol out 
best-selling guide to htgn-petformance 
DOS techn ques and uttoloes-wnh del a Is 
on Versoon 3.3. Con' g utatton. 110. c oree
lOry s;ructures. haJd d s~s. RAM dtSks. 
batcn ltte programming, the ANSI SYS 
devoce drovet, more Through Versoon 3 3 

Understanding DOS 3.3 
Judd Robbins 
676pp. Rei. 646-0 
Thts besl selling, in-depth tu1011al 
addtesses the needs or users a1 all levels 
Wllh many examples and hands-on exer
e-ses Robbms dtscusses the fundamen· 
tals of DOS, :her covers manrputatong 
f,Jes and d11eclcries using lhe DOS eottor. 
pnmrng, communrcatong, and hnrshes 
vnlh a 'ull seclion on ba:ch fries 

Understanding Hard Disk 
Management on the PC 
Jonathan Kamin 
SOOpp Rei. 561- 1 
Thts tille is a key productivily toot lor all 
nard dtSk users who want efftaent. CffOI · 

tree hie management and Ofgantzatton. 
Includes dela Is or tne bes; ways to con
serve nard d Sk space wnen usong sever a 
memoty-guzzhng programs Through 
DOS 4 

Up & Running 
with Your Hard Disk 
Klaus M Rubsam 
140pp. Rei . 666-9 

A far-sighted, compact inlroduction to 
hard disk rnstallalion and basoc DOS use 
Perfect lot PC users who wanl lhe practo
cal essentrals tn the shortest possoble ume 
In 20 baste s1eps learn 10 choose your 
hard d1s1<. work ,,,,lh accessories bacl< 
up data use DOS u~hhes 10 save trme 
and more 

Up & Running with Windows 
266/386 
Gabriele Wentgos 
132pp. Rei. 691-X 
This handy 20-slep overvrew gives PC 
users all the essentoals of usrng 
Windows-whet11er for evalualing the 
sohware, or gettong a last slart. Each self
contained lesson lakes 1us; 15 minutes to 
one hour to oomple:e 

COMMUNICATIONS 

Mastering Crosstalk XVI 
(Second Edition) 
Peter W. Gofton 
225pp. Rei 642-1 
ln:roducong 1ne communicattons orogram 
CrOSSia'< XVI lor tne IBM PC. As well as 
provtding extensove examples of com
mand and scnpl foles for programming 
Crosstal", 1nis book tncludes a delatled 
desocnplion of how to use lhe program's 
more advanced features. sucn as wrn
dows. lalking 10 mint or mainframe, cus
tOmizong tho keyboard and answering 
calls and background mode. 

Mastering PROCOMM PLUS 
Bob Campbell 
400pp. Ref 657-X 
Learn a I aboul c:cmmunocalions and tn'or
ma~on relrieval as you master and use 
PROCOMM PLUS. lopocs incude choos:ng 
and usong a modem; automaoc d'ahng; 
using on·ltne serviCes (leatunng Compu
Serve) and more. Througn Version 1.1 b; 
also covers PROCOMM. the "shareware" 
version. 
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• Speed Disk unfragments and rearranges your 
files to restore lost disk performance. 
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rnu : 147 

Und : 7 .7 H 
Fr• t : 11 .2 H 

Tot•l : 19.0H 
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